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Chapter 1

About SW-1

Welcome to SW-1, Thickness Design Software for Asphalt Pavements from the
Asphalt Institute! SW-1 is a powerful tool for use in design and analysis of asphalt
pavement structures for a wide variety of applications.

SW-1 provides a computerized methodology for thickness design of asphalt
pavements for a wide variety of pavement uses. With this single program, a user
can design pavements for the following vehicle types and uses:

e Commercial Airports

e General Aviation Airports
e Highways

e Roads

e Streets

e Parking Lots

e Port and Marine Facilities

¢ Industrial and Heavy Wheel Load Applications

SW-1 also provides the advanced user the capability to conduct straightforward, yet
powerful structural analysis of special pavement structures using DAMA.

SW-1 is based on the respected design procedures of the Asphalt Institute as
detailed in several Asphalt Institute manual series (MS), information series (IS), and
research report (RR) documents. These methods are based on mechanistic-
empirical principles and have been developed and refined over a period of 30 years
by the Asphalt Institute.

While SW-1 is a stand-alone computer program, the user is encouraged to become
familiar with the individual design procedures that are used in the program. The
Asphalt Institute methods differ in some ways to other common pavement design
methods and it is best that the user is fully aware of the background, assumptions,
and conditions that apply to each thickness design procedure. Table 1 lists the
pertinent Asphalt Institute documents that form the basis of the methods included in
the SW-1 thickness design software.



Table 1—Index to Asphalt Institute Publications

Publication | Pavement Use

1S-91 Asphalt Pavements for Parking Lots, Service Stations, and Driveways

IS-154 Thickness Design—Asphalt Pavements for General Aviation Airports

Asphalt Pavement Thickness Design—A Simplified and Abridged Version of

IS-181 the 1981 Edition of the Asphalt Institute’s Thickness Design Manual (MS-1)
MS-1 Thickness Design—Asphalt Pavements for Highways and Streets

MS-11 Thickness Design—Asphalt Pavements for Air Carrier Airports

MS-17 Asphalt Overlays for Highway and Street Rehabilitation

MS-23 Thickness Design—Asphalt Pavements for Heavy Wheel Loads

RR-82-2 Research and Development of the Asphalt Institute’s Thickness Design

Manual (MS-1) Ninth Edition

The hyperlinks in this table will direct you to the appropriate page on the Asphalt Institute
website where you can find details, pricing, and ordering instructions.

Background

SW-1 is a new Microsoft Windows-based computerized method for pavement
thickness design that builds upon four familiar Asphalt Institute DOS computer
programs for pavement design. The four DOS-base programs were DAMA (CP-1),
HWLOAD (CP-2), AIRPORT (CP-3), and HWY (CP-4).

The developers of SW-1 embedded the original computational algorithms from
DAMA, HWLOAD, AIRPORT, and HWY into SW-1 and developed a new Windows
user-interface to collect input data, report output, and manage data files.

One of the benefits of this approach is a versatile and powerful new user-interface
that allows the user to solve a wide variety of problems from the same program.
The effect of this design approach is that SW-1 has the same look and feel of
Windows-based programs while maintaining the computational integrity of the
original DOS-based programs, all within a single, straightforward, package.

What’s new in SW-1?

SW-1 offers users new functionality and versatility in handling a wide variety of
pavement designs. The Asphalt Institute was motivated to develop SW-1 due to the
age of the older DOS-based programs and the many benefits of using a familiar
operation system such as Windows. As such, SW-1 users reap the benefits of
having access to the venerable Asphalt Institute thickness design methods all within
the comfortable and familiar user-interface that operates on the latest computers.
Specific benefits are:



e SW-1 is designed to run on common Microsoft Windows operating systems
including Windows XP.

¢ New Windows-based User-Interface dramatically eases the use program use.
¢ Improved data file handling and management capability.

e Extensive HELP file and companion User's Guide addresses common technical
and procedural questions in pavement design problems.

e Retains the computational integrity of the legacy programs DAMA, HWY,
AIRPORT, and HWLOAD.
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Chapter 2

Installing SW-1

SW-1 is Distributed as a Trial Version

SW-1 is distributed as a trial version. The trial version operates for a period of 30
days to allow users the opportunity to view example problems, get a better
understanding of the capabilities in SW-1, and make a decision whether to purchase
a software license. When a user purchases and activates a license for SW-1, the
full capability of SW-1 is unlocked. This process is called license activation.

CD-ROM Web Download

Figure 1--CD-ROM and Web Download Versions of SW-1 are the same

Interested users can obtain a copy of SW-1 from either a CD-ROM or by
downloading a copy of the program from the Asphalt Institute website. Regardless
of how the program is distributed, a user can install SW-1 from the following file:

SW1-Install.exe

Before installing SW-1, take a moment to review the system requirements listed in
this chapter.

System Requirements

SW-1 is designed to run on a variety of computer platforms and Windows operating
systems. Your computer must meet the following minimum requirements:

o Computer: IBM or compatible Pentium 200 or higher
e Operating System:

a. Windows 98, 98SE

b. Windows ME
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c. Windows NT
d. Windows 2000 Professional
e. Windows XP Professional or Windows XP Home Edition
¢ Memory: 32 MB RAM (128 MB RAM recommended)
e Hard Disk Space: 100 MB of available hard disk space
e Monitor: SVGA (800x600) with 256 colors
e CD-ROM Drive: Double speed or higher
e Printer: Any printer supported by Windows 98/ME/NT/2000/XP

Installation

Note: If you have a previous version of SW-1 installed, you must uninstall it before
you can install this version of SW-1.

To install SW-1

1. Locate the file SW1-Install.exe on the CD-ROM or in the directory where it was
downloaded. Double-click the file to begin the installation process.

T

Asphalt Institute SW-1

——
- Welcome to the InstallShield Wizard for Asphalt
Institute SW-1

The InstallShield® Wizard will install Asphalt Institute S'-1 on
your computer. To continue, click Next.

INext > Cancel

2. On the InstallShield Wizard for SW-1 Thickness Design Software Welcome
screen, click Next.

12



Setup

Choose Destination Location
Selectfolder where Setup will install files.,

Setup will install Asphalt Institute SYW-1 in the fallowing folder.

To install to this folder, click Mext. Tainstall to a diferent folder, click Browse and select another
folder

Destination Folder

C\Program Files\Asphalt Institute SW-1 Browse. .
<Back MNext > Cancel ‘

3. The next window allows you to choose where the SW-1 files will be installed on
your computer. In the Choose Destination Location window, you can select the
default location or use the browse function to select a custom destination
location.

If you want to accept the default location, click Next to continue installation.

If you want to install SW-1 in a different directory, click Browse. You will be
directed to a separate Choose Folder window as shown below. Once you have
selected your installation directory, click OK. On the Choose Destination
Location window, click Next to continue installation.

Choose Folder B‘

Please choose the installation folder.
Fath:
[C:\Program Files\Asphalt Institute SW-1

Directories:

2 Asphalt Institute DOS Programs ~
(=3 Asphalt Institute SW-1
[#2) Thickness Suite
#I2) ATI Technologies
# ) Common Files
I ComPlus Applications
I) eFax Messenger 3.4
[0 epg

I RSN

[ OK H Cancel ]

4. Once the installation process is complete, the InstallShield Wizard Complete
window will appear. Click Finish to close complete the Setup process and close
the window. Remove the CD from the CD-ROM drive and store in a safe place.
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InstallShield Wizard Complete

Setup has finished installing Asphalt Institute SW-1 an your
computer.

Finigh |

If the opening screen does not appear
Sometimes, a computer’'s CD-ROM drive does not automatically start a CD.
To start the installation from the SW-1 CD
1. On your desktop, double-click My Computer.
2. In the My Computer dialog box, double-click the icon for your CD-ROM drive.

3. From the list of files, double-click SW1-Install.exe.

Trial Version Evaluation

Once SW-1 is installed, the user will have access to a set of example problems
which showcase the capabilities of the software package. The evaluation period
can last up to a period of 30 calendar days from the date of installation.

At any time during the 30 day evaluation period, the user can activate the program
by starting SW-1 and following the activation prompts or by selecting Help >
Activate SW-1.

After 30 days, the evaluation period will have ended and the user will no longer be
able to run the program in evaluation mode. Upon starting SW-1, the user will then
be prompted to either activate the software or to close the program.

License Activation

In order to unlock the full capability of SW-1, you must first purchase a license and
activation key from the Asphalt Institute. By entering the activation key code into
SW-1, the trial version will be converted to a fully operational version of the
software.
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Note—The Asphalt Institute currently sells SW-1 licenses to individual users for use
on a single computer. Site licenses for multiple users are not currently offered, but
may be offered in the future.

The licensing process binds SW-1 to one computer using a system of encrypted
codes. The codes used during the activation process are unique to the computer
system on which SW-1 is being installed. If you want to install SW-1 on more than
one computer, you will need to purchase an additional license.

There are six steps in licensing the SW-1 software.
To obtain alicense and activate SW-1

1. When you start SW-1 during the trial period, you will see the Activation dialog
box during start up. Click Activate Now to initiate the activation process.

Activation

SW-1 Thickness Design
A Software
This copy of SW-1 has not been activated. This

Asphalt Institute demonstration license will expire in 27 day(s).

“ Activate Now ”

| want to continue running the demo version ‘

As an alternative, you can select Help > Activate SW-1 from the main menu
within the SW-1 program

2. On the following SW-1 Activation screen, you will be prompted to contact the
Asphalt Institute to obtain an activation key. If you have not paid for the
software, you will first be asked to purchase the software. If you have already
paid for the software and are just obtaining a license, you can skip to the next
step.
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SW-1 Activation

To activate SW-1, you mmust purchase the software and obtain an activation
key. To purchase SW-1 on-line click here

If you purchase online, you can enter your code (below) and an activation
‘ key will be e-mailed to you. Or. you can obtain an activation key by phone,

fax or email (be sure to inclhude your order number in your email or fax):

Asphalt Institute

phone: (859) 288-4961
fere: (839) 285-4999
email: pubs@asphaltinstitute.org

Code: 319501244-7397720 Copy Code to Clipbosard

If you are going to activate by email or fax, write down or copy the
Code above and inchide it in your email or fax. Then press the Wait
"Wait' button and come back to this screen after you receive a

response.

If you are activating by phone, or if you already recetved your key,
enter it below and click the OK button. 0K
Activation Key: ‘

Note—If you contact the Asphalt Institute by telephone, please be aware that our
office is in Lexington, Kentucky, in the U.S. Eastern Time zone (GMT -05:00 hours).
Our office is staffed during normal business hours, 8:00 AM to 5:00 PM, Monday
through Friday. You can email or fax your User Code to the Asphalt Institute at any
time. Our representatives will respond as soon as possible once we receive your
payment and User Code.

3. Submit the Code that appears on the activation screen to the Asphalt Institute
representative. This code can be submitted by email, fax, or by phone. Once
you have submitted the code, you can click Wait to operate SW-1 in the
demonstration mode until you receive your activation key. The following
message will appear until you correctly enter the activation key.

= _ __

Activation Failure

\l.) Activation incomplete or incorrect, reverting to demo mode.

4. Within a short time, the Asphalt Institute representative will provide you a unique
activation key that will unlock SW-1 and serve as your software license.

5. Enter the activation key in the box on the SW-1 Activation screen and click OK
on the Activation screen to complete the license activation process. The
following message confirms that the activation process has been successfully
completed.

SW-1 Activated

\i«) Activation successfull Thank you for purchasing SW-1.




If you need to transfer SW-1 to another computer

During the license activation process, SW-1 will be bound to your computer using a
series of encrypted codes. Your software license allows you to install SW-1 on a
single computer. If you need to have SW-1 installed on more than one computer
simultaneously, you must purchase and activate a second license for the second
computer.

You may have a need to transfer SW-1 from one computer to another. This occurs
most commonly when a user upgrades his or her old computer to a newer model.

To transfer SW-1 from one computer to another

Note—You must install SW-1 on the new computer prior to attempting to transfer a
license. Follow the installation instructions provided earlier in this chapter.

1. On the new computer, open SW-1 and select Help > Transfer SW-1 License >
Step 1. Execute on new machine

FA SW-1 Thickness Design Software - [Jasper Street Extension]
Fe B

iPro] Help Contents bgrade | Results |

Help Index

I pcovate sw-1 flension k2
Transfer SW-1 License * Step 1: Execute on new machine
EOOUESWLT Step 3: Execute on new machine

l

This step creates a file called Transfer.lf. Click Browse and identify the directory
where you would like to create Transfer.If.

Transfer License

Locate the Transfer If file created by execufing Step 1 on the new machine.

JE'\Tran pram — Eimwse ]

OK ‘ Cancel ‘

After you identify the path to the desired location to create Transfer.If file, click OK.
SW-1 will then create the Transfer.If file in the specified location. A dialog box will
appear instructing you to copy the Transfer.If file to the old machine.

i‘) Transfer step 1 successful. To execute step 2, take the transfer fie to the machine with the

already-licensed copy of SW-1

Copy the Transfer.If file from the new computer to the old computer.
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2. On the old computer, open SW-1 and select Help > Transfer SW-1 License >
Step 2: Execute on old machine

FA SW-1 Thickness Design Software - [Jasper Street Extension]

Fie W3E]
[Pro|  Help Contents [bgrad- | Resuits |
: Help Index
| ‘r‘lens:on |
R g
|

Locate the Transfer.If file you just copied to the old computer. To locate the file,
click Browse and locate, on the old computer, the directory to which Transfer.If
was copied. Once you have identified the path for Transfer.If, click OK.

Transfer License

Locate the Transfer If file created by execufing Step 1 on the new machine.

JE:\TranSferIf Bmwse

OK ‘ Cancel ‘

At this point you have successfully completed step 2 in the license transfer process.
The copy of SW-1 on the old machine will no longer be fully licensed and will revert
to the trial version of the software. Click OK to continue to Step 3.

i Transfer step 2 successful. Copy the transfer fie to the new machine and execute Step 3.
“u) This copy of SW-1 wil revert to demo mode.

3. The last step of the transfer process will activate the full version of SW-1 on the
new machine. This step requires that the Transfer.If file created in Step 1 and
used in Step 2 be copied back to the new machine. On the new machine,
initiate Step 3 by selecting Help > Transfer SW-1 License > Step 3. Execute
on new machine.

@

FA SW-1 Thickness Design Software - [Jasper Street Extension]

File QziEH]
[Pre|  Help Contents ibgrade | Resuits |
Help Index
b Actvate sw- fiension ~|
QICUEEESUE NI Y Step 1: Execute on new machine
About SW-1 | Step 3: Execute on new machine

In the Transfer License dialog box, click Browse to locate the Transfer.If file.



Locate the Transfer If file created by executing Step 1 on the new machine.

[E\Transferf

OK ‘ Cancel ‘

Once the Transfer.If file has been located, click OK to transfer the license to the
new computer. If the transfer is successful, a dialog box will appear instructing you
that the license transfer to the new machine has been successful. Click OK.

Transfer Successful @

\i.) The license has been transferred.

If you need to uninstall SW-1

If you need to remove SW-1 from your computer use the Add/Remove Programs
feature in your version of Windows.

Note: The following information applies specifically to Windows XP Professional.
Please refer to the specific documentation provided with your version of Windows
for specific instructions.

1. On the Windows taskbar, click Start > Control Panel

2. Double-click Add or Remove Programs

;j Add or Remove Programs g@
=) ] —
@ Currently instaled programs: Sort by: | Name |v|

Changeor | [ Tal
Eem%v g &5 RAW FILE CONVERTER LE Sze  3.26MB |
Programs Q) RealOne Player Size 26.27MB
& @ Remaote Control Panel Size 0.80MB
. »
Add New & Rights Management Add-on for Internet Explorer Size 2.23MB
Programs bl Samsung SCX-4x16 Series Size 0.85MB
15 50X-4x16 Series Size 1.59MB
13 smarThru Size 2.29MB
Add/Remove
Wﬁndows € Support.com Software Sze  32.00MB |
S ! ||
Components {51 w1 Thickness Design Software Sze  1.0SMB | - |
Set Program To change this program or remove it from your computer, click
Py ey yo Change/Remove
Defaults I . p
ThinkPad FuliScreen Magnifier Size 2.12MB
‘15' ThinkPad_Features Screen Saver r
|
lme o = o . oaeen - —

3. From the Add or Remove Programs window, select SW-1 Thickness Design
Software and click Change/Remove.

4. Click Yes to confirm uninstall.

19



5. When uninstall is complete, click OK.

If you need assistance

20

The first place to look for help is in this User's Guide or the Help File embedded
within SW-1.

In addition, be sure to check the SW-1 Support section of our website at

http://www.asphaltinstitute.org/thicknessdesignsw/

You will find a technical library, FAQs, and support contacts including a technical
support contact form.

You can send us an email at sw1@asphaltinstitute.org

Our World Wide Web address is http://www.asphaltinstitute.org




Chapter 3

Basic Operations

SW-1 was designed for pavement design professionals who may have the need to
design pavements for a wide variety of uses including airports, roadways, and
parking lots. Rather than turn to individual specialty programs for each type of
pavement, the SW-1 integrates its pavement thickness design tools in a single
program for exceptional versatility.

The key to this versatility lies in the Project Definition screen, SW-1’s opening
screen. On the Project Definition screen you can define the project to be designed
by selecting the Pavement Use (i.e. general aviation airport or highways, roadways,
and streets) and the Project Type (i.e. new pavement or overlay). Once you define
the project, SW-1 creates the proper tabs to step you through the specific design
problem-at-hand.

This chapter covers basic operations that are common to all pavement designs
completed in SW-1. This includes file operations, managing data files, screen
layout, managing project records, defining units, project definition, view results, and
printing from SW-1.

File Operations

Underlying the user-interface, SW-1 is powered by a Microsoft Access database.
SW-1 files are saved in Microsoft Access format using a *.MDB extension. SW-1
uses common Windows file operations to open, save, rename, and delete files.

There are two levels of hierarchy in managing files and projects in SW-1: data files
and project records. At the higher level in the hierarchy, you can create and
manage data files using the File > New or File > Open operations from the SW-1
main menu. Within each data file, you can establish and manage numerous project
records. In the example in Figure 2, data file SW-1 Example Problems.mdb
includes nine project records.

21



Data File —_ SW-1 Example Problems.mdb

/ s N s N
US 195 Harper to Ironsides OR 31 Paisley to Valley Falls
(. J | J
4 R 4 )
Mill Plain Boulevard Palmdale Airport Taxiway C
| J | J
Project 1 ) 1 )
Records Wolf Creek Road Palmdale Airport GA Parking Apron
(. J (. J
( N ( N\
Warm Springs Log Sorting Yard SW 4" Avenue—Jefferson to Burnside
(. J (. J
4 7\
k OR 203 Union to Medical Springs
(. J

Figure 2—SW-1 relationship between data files and project records

Managing Data Files
To create a new data file

1. On the SW-1 menu, select File > New

FA sW-1 Thickness Design Software - [Palmdale Airport Taxiway C]

limate | Traffic | Subgrade | Resuits |

[Feimdisie Alrport

New | Copy ‘ Delete | Rename ‘

2. In the Enter New Database Name window, go to File Name and enter the name
of the data file you wish to create.

Enter New Database Name:

Lookin: ‘_JExampIe j &5 E-

E 21 City of Salem.mdb
7 f} [ EX_0DOT_PROJECTS.MDB
> ) EX_PALMDALE_AIRPORT.MDB
My Recent 2] ExampleData.mdb
Documents 21 Pierce Transit.mdb
=) ZH PLANT42.MDB
L [ port of Everett.mdb
)RR 82-2 Examples.mdb
Desktop @JSBA.mdb
. 2 sw-1 Example Problems.mdb
[EUs Bank Troutdale.mdb
[ washington County.mdb
) WASHINGTON_DOT_PROJECTS.MDB
2 weyerhauser.mdb

My Computer
File name | ﬂ Open |
. Files oftype: |Database Files (*.mdb) ﬂ Cancel
[~ Open as read-only

22



3. Click Open.

To open an existing data file

1. On the SW-1 menu, select File > Open

2. In the Enter New Database Name window, select the data file you wish to open

3. Click Open.

Screen Layout

The SW-1 program incorporates a user-friendly interface. The opening screen that
you come to is called the Project Definition screen. On this screen you can manage
project records, select units of measure, and define the pavement use and project

type for your specific application.

The Pavement Use and Project Type regions of the Project Definition screen appear
grayed out, indicating the selected pavement use and project type for the problem.
Pavement Use and Project Type are selected during the process of creating a new
record in the Project Record region of the screen.

¥ X SW-1 Thickness Design Software - [Jasper Street Extension]

Fie Help

Project: |Jasper5(reet Extension

il

New ‘ Copy | Delete ‘ Renﬂme‘

Description:

L OX
== le]ect-Records Units

Example Problem—See 5W-1 User's Guide Chapter 10

Pavement

=

Use

g

=

Unit: [0

Creating New Project Records

One of the primary advantages of the SW-1 program is its ability to solve a wide
range of pavement design problems. The key to this versatility lies in the ability to
“define” a project as the project record is created. Project Definition is accomplished
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by selecting the appropriate radial buttons for Pavement Use and Project Type on
the Create New Project screen.

Pavement Use is determined primarily by the vehicle type that will use the pavement
facility. There are five distinct pavement uses defined in SW-1. For aircraft, SW-1
distinguishes between air carrier airports and general aviation airports. For cars and
trucks, highways, roadways, and streets are designed with methods that are
different that those for parking lots, driveways, and service station lots. Lastly, SW-
1 has the capability to design pavements for heavy equipment that operate at port
facilities, log-sorting yards, and other industrial applications.

To define Pavement Use select the appropriate radial button

Create New Project

Project Name: ‘

Pavement Use Project Type

Aircraft

* N P t Desi MS-1
" Air Carrier Airports ® New Pavement Design ( )

~ Two-Phase Design (M53-1+ MS-17),
(" General Aviation Airports Effective Thickness Overlay
(" Flanned Staged Construction

Cars and Trucks

(@ Highways. Roadways and Streets " Overlay
Parking Lots, Driveways. and Service
Stations
Heavy Equipment (" Simplified Design Method (15-181)
~ Port Facilities and Heavy Wheel Load " Advanced Structural Analysis (DAMA)

Applications

| Cancel

Note: You must select both Pavement Use and Project Type in order to properly
set up a project and establish the proper screens to complete the pavement design.

To define Project Type select the appropriate radial button

The Project Type area of the screen would look like this when Highways, Roadways
and Streets is selected as the Pavement Use

Create New Project

Project Name: ‘

Pavement Use Project Type

Aircraft

® NewP t Desi MS-1
(" Air Carrier Airports b b avEmenshesIan )

Two-Phase Design {M53-1+ MS-17).
(" General Aviation Airports Effective Thickness Overlay
(" Planned Staged Construction

Cars and Trucks

(® Highways, Roadways and Streets (" Overlay
Parking Lots. Driveways. and Service
Stations
Heawvy Equipment (" Simplified Design Method (15-181)
Port Facilities and Heavy Wheel Load (" Advanced Structural Analysis (DAMA)
Applications

Cancel




Note: In the Asphalt Institute methodology, only certain combinations of Pavement
Use and Project Type are valid. Upon selecting a Pavement Use on the left half of
the screen, only valid Project Types for the selected Pavement Use will be visible on
the right half of the Project Definition screen.

When Port Facilities and Industrial Applications is selected as the Pavement Use,
the Project Type area of the screen would offer only two options, New Pavement
Design (MS-23) and Overlay.

Create New Project

Project Name: |

Pavement Use | rProject Type

Aircraft

® New P t Design (MS-23
" Air Carrier Airports ew Pavement Design (| )

(" General Aviation Airports

Cars and Trucks

(" Highways, Roadways and Streets (" Overlay
Parking Lots, Driveways. and Service
Stations

Heavy Equipment
Port Facilities and Heavy Wheel Load ;
Applications

(o

Cancel

Managing Project Records

Project records can be managed using the Copy, Delete, and Rename buttons in
the Project Records area of the Project Definition screen.

To copy a project record
1. On the SW-1 Project Definition screen, click Copy

2. In the Copy Project window, enter a name for the copied project record in the
space provided, then click OK.

Copy Problem

Name for copy
Cancel

e

lcopy of AMEC)

To delete a project record
1. On the SW-1 Project Definition screen, click Delete
2. In the Confirm Delete window, click OK.

To rename a project record
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1. On the SW-1 Project Definition screen, click Rename

2. In the Rename Project window, enter the new name for the project record in the
space provided, then click OK.

Rename
Please enter new name for Garfield Road.
Cancel

(Garfield Road

Defining Units

SW-1 allows you to select either US Customary or Metric units from the Units
dropdown list on the Project Definition screen. This selection applies to all aspects
of the project including inputs for climate, traffic, subgrade as well as results.

Units: -
S Customa

Metric

Viewing Results

FA SW-1 Thickness Design Software - [Warm Springs Log Sorting Yard]

Fie Help
Project Definition | Climate | Traffic | Subgrade | Results \

Design Summary

’ Pavement Design Detail Report A
A

SW-1 Thickness Design Software version 1.0

Asphalf Instifufe
2

ERL
:—: B Hua
% 1 De_sign
= Thickness
=
L 5
=
'_
0
Layers
User: John Duval Date: |8/16/2005 Time: 14:04
Project Information
Project Name: ‘Warm Springs Log Sorting Yard E
Result Re‘pnrl - - :
C Summary @ Detail! Gant

For any project in SW-1, results can be viewed by either proceeding through the
pavement design program using the Next button. Alternatively, for existing project
records, results can be viewed simply by selecting the Results tab. Upon selecting
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the Results tab, SW-1 runs design calculations and presents the results in a text
report.

Report Format

In most cases, the SW-1 program reports results in two formats—a summary or
detailed version of the report. A summary report typically shows basic project
information and the design results. The detailed report lists project information,
subgrade, climate, and traffic inputs along with the design results. You can scroll
down to view the reported results and preview the entire report. The summary report
format rarely exceeds one-page in length, while some detailed reports can be
several pages long. For most reports, a simple graphic at the top of the page shows
relative layer thicknesses on a graphic scale.

Printing
To Print a Pavement Design Report

1. On the Results tab, choose Summary or Detailed report format

2. Select the Print button.

; Print Preview
prnt. [ @] % « poge[1 oz = * |6 G NSNS v | Help | ose
Pamz 1of 2

Pavement Design Detail Report

A SW-1 Thickness Design Software version 1.0

e

Desien Pavement Cros S ection
Required Tot! FIMA Thickness H‘ &

Thickness (in.)

e [Foa Duval leee: 162005  [Time 104
ect n

D crigtion

veman Us:
[Probizm Typs

llndividual Wheel Lasds ] !

(Calculztion Point Inform ation:

[Resilint Moduls (M)
A

fileC SW-1Thicimess Suite Warn Scrines Loz Sontine Vard0s §182005 file:/C 7 Program Files Asszlt Institwe SW-1 Thickness Suite' Werm Sorings Lo Sortine Yaras 9162005

Note: Reports are automatically displayed in Print Preview mode to allow you to
view the report as it will be printed. Various zoom levels can be selected to allow
viewing the report at several levels of detail.

3. From the Print Preview screen, select Print.
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4.

General ‘Optiuns‘

In the Windows Print window, select the desired printer and select Print.

SelectPrinter
2 File Print FedEx Kinko's
2 hp LaserJet 1012
< Microsoft Office Document Image Writer
_J5amsung SCX-4x16 Series
: |

5 Samsung SmarThru Fax

LY
Status: Ready [IPrintto file
Location: Al Portland Office

Comment  Printer/Scanner Find Printer.

Page Range
@Al

MNumber of copies:

I

O Current Page

Opge
Enter either a single page number or a single
page range. Forexample. 5-12




Chapter 4

Climate

Climatic conditions affect the behavior of pavement materials. For hot-mix asphalt,
the stiffness of the layer depends on the temperature of the mat. Consequently,
temperature affects the response of the HMA layer to loading and affects the critical
strains that result.

For unbound aggregate and subgrade soils, we are concerned primarily with
freezing and thawing conditions that will affect the stiffness of these materials.

SW-1 accounts for variations in climate in two ways. First, for most analyses, SW-1
uses an average temperature to characterize the climate conditions that apply to the
project at hand. SW-1 does this by asking the user to specify the mean annual air
temperature (MAAT) for the project location. Once the MAAT is selected by the
user, SW-1 applies the appropriate corrections to account for temperature effects
such as freeze-thaw. In the advanced structural analysis using DAMA, SW-1 offers
the ability to input monthly temperature variations. More details follow below.

Mean Annual Air Temperature

The Asphalt Institute design methods make allowance for the influence of climate, or
more specifically temperature, on pavement performance. The input needed in the
analysis is the mean annual air temperature (MAAT) for the design site.

MAAT is a simplified way of describing climate conditions that have common cyclic
temperature variations. Although we use MAAT as an input in the pavement design
process, it is important to recognize the significance of MAAT and the inherent
variability that it assumes.

An example of three different MAAT levels is shown in Figure 3. This figure shows
the monthly temperature variations for the three MAAT levels used in the
development of MS-1, namely 45°F, 60°F, and 75°F which correspond to New York,
South Carolina, and Arizona, respectively. All three locations have significant
variation in air temperature over the course of a year. For example, in New York,
MAAT45, the monthly air temperature averages dip below freezing during the
months of January through April. During this period, all layers will experience
increased stiffness due to the cold. In April, as the temperature climbs, some
thawing is to be expected, which will likely weaken the subgrade soils. After thaw
weakening, temperatures warm up during the spring and summer months and HMA
layers will experience lower stiffness as pavement temperatures climb. In the fall,
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Figure 3—Variation in Mean Monthly Air Temperatures for Selected MAAT

as the temperatures cool off, HMA stiffness will begin to increase and the cycle
repeats.

Freezing and Thawing

30

One of the primary advantages of analyzing variations in temperature of pavement
structures is to allow for the freezing and thawing effects of subgrade soils and
unbound base aggregates. Under freezing conditions, the stiffness of these
underlying foundation materials increases dramatically. During the spring thaw,
these same materials may experience a major reduction in stiffness due to the
presence of the melting water.

These factors are considered in the selection of a representative MAAT for the
pavement. For highway, street and road design, three sets of environmental
conditions were selected to represent the range of conditions to which this
procedure applies:

Table 2—MAAT Levels and Frost Effects

MAAT Frost Effects
45 °F Yes

60 °F Possible
75 °F No




Another way to describe these three MAAT levels is that for MAAT45, freeze-thaw
will occur during the cycle. At MAATG60, some freeze-thaw is possible with warm
summer temperatures. Freeze-thaw is not considered at MAAT75 and hot summer
temperatures will result in low HMA stiffness.

Note: Typically the 30-year mean is recommended for use in calculating a mean
average annual air temperature. Air temperature information can be obtained from
the National Weather Service station nearest to the site. For more information see
the following website: www.nws.noaa.gov.

Note: While MAAT is used for most airport, highway, and heavy wheel load
analyses, users wanting to perform a more detailed analysis can perform an
advanced analysis using DAMA. DAMA allows the user to analyze the influence of
monthly variations in temperature the pavement structure. For more information see
Advanced Structural Analysis on page 85

SW-1 and MAAT Levels

The Asphalt Institute pavement design methods have evolved and been refined over
the years with respect to MAAT levels. As described above, there are three MAAT
levels in the highway design method detailed in MS-1. There are eight separate
levels in the air carrier airport design method and only two levels in the heavy wheel
load method. These differences reflect the evolution of the Asphalt Institute
methods over the years. SW-1 maintains the legacy of the Asphalt Institute
methods and uses the MAAT levels that correspond to the respective publication
and “manual” design methods shown in Table 1 on page 8.
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Chapter 5

Subgrade

On the subgrade screen, the user is asked to supply subgrade stiffness values as
inputs to the pavement section design calculation. SW-1 uses the resilient modulus
to characterize subgrade stiffness, but can correlate from CBR or R-values is the
user has this type of information.

The user is asked to select the type of strength measure, input the stiffness values,
and select a design subgrade value in order to calculate the Design Subgrade
Resilient Modulus.

Types of Strength Measure

The basis for subgrade strength measurement in this program is the subgrade
resilient modulus, which can be determined from a laboratory test in accordance
with AASHTO Method T 307.

In order to facilitate the use of other widely used tests, correlations have been
established with the California Bearing Ratio (CBR) and the Resistance (R) value.
Procedures for performing CBR and R-value tests are detailed in MS-I0 and ASTM/
AASHTO test methods:

In SW-1 the default relationship used to correlate resilient modulus from a CBR test
values is as follows, but may be changed by the user:

M; (psi) = 1500 CBR

Similarly, the default relationship used by SW-1 to correlate resilient modulus from
an R-value test is as follows:

M, (psi) = 1155 + 555 (R-value)

CBR and R-value correlations are considered applicable to fine-grained soils
classified as CL, CH, ML, SC, SM, and SP (Unified Soil Classification) or for
materials that are estimated to have a resilient modulus of 30,000 psi. or less.
These correlations are not applicable to granular materials, such as base aggregate,
which may require direct laboratory testing to obtain resilient modulus values.
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Selection of Design Values
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The Design Subgrade Resilient Modulus is the value of the subgrade resilient
modulus (MR) used for designing the pavement structure. It is a percentile value of
the subgrade resilient modulus test data distribution.

One or more individual data points may be used to characterize subgrade stiffness.
If a single value is used, SW-1 selects it as the design value. If a set of two or more
test values, the default subgrade design value is as shown in Table 3, but the user
is allowed to override the default value by selecting a subgrade design value from
the drop-down list.

This procedure allows the user to look at the statistical significance of the data set
before selecting the design value. It requires more conservatism as the traffic
volume increases and allows for less conservatism on low volume designs.

Table 3—Recommended Subgrade Design Values

Pavement Use Traffic Level Design Subgrade
Value, Percent

10* ESALs or less 60

Highways, Roadways, Between 10" and 10° 75

and Streets ESALs
10° ESALS or more 87.5

Airports All 85

Port Facilities and Heavy

Wheel Loads Al 85

However, for a large sample size, which typically results from a nondestructive
testing program, a more direct statistical approach can be applied. If the number of
sample data points is 30 or more, a normal distribution can be assumed for
computing Mr using the following relationship:

Design M, =x-Z2*S
Where:

X = average of all data
Z = Z statistic based on the design percentile value
S = sample standard deviation

For more detail on selecting design resilient subgrade modulus, please see one of
the following Al manuals: MS-1, MS-10, MS-11, MS-17, or MS-23.



File Help
Type of Strength Measure
CBR |
Subgrade CBR values:
CBR Value
22
25
14
27
b |16
Add Row | Delete Row ‘

Project Definition | Glimate | Traffic | Subgrade | Gross Section | Resuits |

Resilient Modulus Calculation

Design ESAL

Using SW-1 to Enter Subgrade Stiffness Values

2,477,636

Recommended Design Strength Percentile:

2

[~ Enter Manually

CBR Correlation Factor, f 1500 psi
[M, = f x CBR] (750 < psi < 3000)

Average M. 29160 psi

Standard Deviation: R231 psi

Design M:

21995 psi

To enter subgrade data

1. Select the type of subgrade strength measure from the drop down list.
three options are CBR, R-value (R), or Resilient Modulus (Mr or M,).

Type of Strength Measure

|cBR

SulR
hr

=]

2. Enter the first subgrade value in the top row of the table.

The

Note: The name of the table will change depending on the type of strength
measure selected in step 1.

Subgrade CBR values:

CBR Value
b |0

Add Row Delete Row
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3. To add additional subgrade strength values, select Add. This will add a row to
the data table. Move to the new row and type in the new value.

4. To delete a value from the data set, place the cursor on the desired row and
select Delete.

5. Continue to add (or delete) rows and entering data until your data set is
complete.

6. For data sets with more than one subgrade strength value, SW-1 automatically
calculates the average and standard deviation of the data set and reports them
on the screen. Using the design subgrade value (%) defined in the details
section of the screen, SW-1 calculates the Design Subgrade Resilient Modulus,
which is also reported on the screen.

Type of Strength Measure
CER ﬂ Resilient Modulus Calculation
Design ESAL 2,477 636
Subgrade CBR values:
CER Value [ Select Manually
22 . Lo o
55 Recommended Design Strength Percentile: 57.5 %
18
27 [ Enter Manually
L Jul CBR Correlation Factor, f 1500 psi
[M = fx CBR] (750 < psi < 3000)
Average M, 32400 psi
Standard Deviation: 5923 psi
Design M;: 24439 psi
Add Row | Delete Row |

The Design Subgrade Resilient Modulus is a percentile value of the subgrade
resilient modulus test data distribution, which is assumed to be normally distributed.
SW-1 automatically recommends a percentile based on the predicted traffic volume.
The user can override the recommended selection by clicking Select Manually and
selecting a percentile level from the drop-down list. Likewise, the user can override
the recommended correlation equation by clicking Enter Manually.

7. Click Next, Back, or select another tab.

Note: The Add and Delete buttons below the subgrade strength value table are
used to add or delete rows to the table. The table defaults to having a single row
and the user must add additional rows to accept more than one data point. SW-1
automatically calculates the average and standard deviation of the data set as well
as the Design Subgrade Resilient Modulus used for the pavement design.




Chapter 6

Air Carrier Airports

SW-1 provides the capability to design HMA pavements for air carrier airports that
will support heavy commercial aircraft. See the next chapter for information on
designing HMA pavements for General Aviation Airports. The comprehensive
design manual on this topic is “Thickness Design—Asphalt Pavements for Air
Carrier Airports,” Manual Series No. 11 (MS-11), which describes this method in full.
This method focuses on the design of Full-Depth asphalt pavements for airports
serving aircraft of greater than 60,000 Ib. gross weight. This method is suitable for
new pavement design as well as the design of HMA overlays for existing
pavements.

Structural design for air carrier airports requires the following inputs: climate, traffic,
and subgrade stiffness. SW-1 uses well-established relationships between mean
annual air temperature (MAAT) and pavement thickness in the design process.
Traffic analysis is needed to assess the number of strain repetitions that occur at a
given critical point within the pavement system. Subgrade stiffness is the key
material property used for structural design. The following are specific steps to set
up a new air carrier problem.

To design a new pavement or overlay for an Air Carrier Airport

1. Select the Air Carrier Airports radial button under Pavement Use.

7 sw-1 Thickness Design Software - [Palmdale Airport Taxiway C]

Fle Hep
Froject Definition | Climate | Traffic | Subgrade | Results |
Projact: r’n]mdnla_Ajrp-:lrlTn:-iwuj.—C: T‘
New | Copy | Delete | Rename
Description: [Example Problem-See SWw-1 User's Guide Chapter 6 Units: (IS, =~ |
Pavement Use Project Type

Adrcrafl ® New Pavemant Dasign (M5-11)
(@ Air Carriar Airports

" General Aviahion Aarporls

Cars and Trucks
 Owverloy
" Highways, Roadwenys and Stoels

 Parking Lots, Diwewerys, and Service Stalions

Heavy Equipmiznt

~ Port Facilities and Heavy Wheel Lond
Applications
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2. Select the appropriate radial button under Project Type (New Pavement Design
or Overlay).

3. Select Next

Climate

Temperature affects the response of asphalt materials to loading, and consequently
affects the critical strain values calculated under traffic loading. Freezing and
thawing conditions also affect the stiffness of supporting unbound base and
subgrade materials. More information is provided in Climate on p. 29

For airport pavement design, eight different MAAT classifications are available.

Select the desired MAAT by clicking the appropriate radial button

fA sw-1 Thickness Design Software - [Palmdale Airport Taxiway C]

File Help

Project Definitio Traffic | Subgrade | Results |

Mean Annual Air Temperature

{” Less than or equal to 40 F

" 45 F

~ BOF

i 5B F

" BODF

i B5F

¢ I0F

® Greater than or equalto 75 F

Traffic
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Traffic analysis for airport pavements is a method for estimating the number of strain
repetitions that are imposed on pavement section. Strain repetitions imposed on the
pavement are a function of the type of aircraft, the gear load, the number of aircraft
passes, and the lateral, or transverse wander characteristics of the aircraft on the
design area. The optimum or design thickness is the thickness that will allow the
pavement to serve, under the strains imposed by the anticipated traffic, for its

design period.

Effects on the pavement of strain repetitions of a mixture of different aircraft are
considered cumulative. The ftraffic analysis procedure permits calculating the
cumulative effects of traffic at different lateral intervals, x, from the taxiway
centerline. This is accomplished by equating the number of strain repetitions
produced by the aircraft traffic mixture to a number of equivalent strain repetitions
produced by an arbitrarily selected standard aircraft. The standard aircraft is a 358
kip DC-8.

This type of standardization procedure is analogous to the use of 18 kip single-axle
load used in highway pavement design.

To enter traffic data for an Air Carrier Airport



1. Find the first aircraft type in the Air Carrier Traffic Information table

2. Enter the number of movements expected during the Design Period for the
aircraft in the Movements in the Design Period column.

3. Continue entering traffic data for each aircraft in the design aircraft mix.

FA SW-1 Thickness Design Software - [Palmdale Airport Taxiway C] B@B|
Fle Help
Project Definition | Climate \ T!:?ffl__l_‘:_‘ Subgrade | Results |
Air Carrier Traffic Information
Aircraft Type Movements in Design Period -
b _|A3N0-B2 1} B
A300-C4 o
B707-1208 i}
B707-320C {or C-141} o
B727-200 (100%) 43600
B727-200 (B0%) 1}
B737-100 1}
B737-300 58400
B747-200{100%) o
B747-200 (80%) i}
B747-5P o
B757-200 29200
B767-200 o
BAC1-11-600 o
CONCORDE 1} |
DC-10-10/10CF (100%) o
DC-10-10/10CF (80%) i}
DC-10-30/30CF o
DC-6-73/73F i}
DC-8-15 o ﬂ
Clear

Note: The aircraft table in the current version of SW-1 includes the majority of
Boeing aircraft, but does not include the Boeing 777. The Asphalt Institute is
working to add the Boeing 777 and Airbus 318/319/320, 330, and 340 to future
version of SW-1. We apologize for the absence of these aircraft in the current
version of our software and look forward to offering them in future versions.

Subgrade

The method for air carrier airports uses the standard inputs for subgrade stiffness as
described in Subgrade on p. 33.

Results

When the necessary input values for climate, traffic, and subgrade have been
provided by the user, SW-1 makes the Next button available to the user on the
traffic screen. By clicking on the Next button, SW-1 will calculate the results of the
pavement design project and create an output report.

For more information on how to review the results of a pavement design, please see
Viewing Results on page 25.
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Example Problem—Palmdale Airport Taxiway C

Problem: The Palmdale Airport is a
commercial service airport in south
Texas that is rapidly expanding. The
climate is hot and dry with MAAT =
75°F. Taxiway C is a new connecting
taxiway that is to be constructed of
HMA to support the Boeing 727, 737,
and 757 aircraft with daily pass levels
of 6, 8, and 4, respectively. The
Geotechnical Engineer hired by the
airport conducted field California
Bearing Ratio (CBR) tests along the
taxiway alignment in six places and
reported the values as shown in
Table 4. The design life for the
taxiway is 20 years. What is the
recommended HMA thickness for a
Full-Depth Asphalt section?

Solution

1. From the Project Definition
screen, select New to create a
new project record and name it
Taxiway C.

2. While still on the Project
Definition screen, select Air
Carrier Airports in the Pavement
Use area and select New
Pavement Design (MS-11) in the
Project Type area. Make sure
that US Customary units are
selected.

3. Click Next.
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Table 4—Subgrade CBR Values for
Palmdale Taxiway C

Test No. CBR
1 12
2 10
3 9
4 13
5 10
6 11

Create

MName for Mew [tem

Taxiway C

¥3 5W-1 Thickness Devign Softwars - [Palmdale Airpart Tasiway €]
Fe tep
Froject Detinman | Camate | Traffic | Subgrage | Resuns |

Profot:  [imimasis A Tasien

Humey Equipment

ot Facibtins naed Homey Wheel Loag
Applcatons




4. On the Climate screen, select
Greater than or equal to 75 F
for MAAT.

5. Click Next.

% 5w-1 Thickness Detign Sofvwars - [Palmdale Arport Tasiway C]

4 Grastur han o sgunl ko 74 F

o sk

6. Calculate the Movements in the Design Period as shown in Table 5.

Table 5—Aircraft Departures for Palmdale Taxiway C Example Problem

. Movements
Aircraft - : -
Daily Annual Design Period (20 Yr)

Boeing 727 100% 6 2,190 43,800

Boeing 737 8 2,920 58,400

Boeing 757 4 1,460 29,200
7. On the Traffic screen, enter the [N ENrT
Movements in the Design i e Tatic

Period.

8. Click Next.

Eirmscis & Gosis Paciod
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10.

11.

12.

13.

On the Subgrade screen, select
CBR as the Type of Strength
Measure and begin to enter the
six Subgrade CBR Values from
Table 4. Use the Add and Delete
buttons to establish six rows for
the input values.

Click Next.

On the Results screen, scroll up
or down to view the Design
Summary.

Review the design summary to
find that Taxiway C will require a
15.7 inch thick Full Depth Asphalt
pavement section to support the
desired level of traffic over 20
years.

Click Finish.

3 5W-1 Thickness Devign Saftwars -

[Palmdale Airport Tasiway C]

Flasdiont Modubss Crlcadnlion

Fintommted Dusign Stnegth Peitentis 3 =

CE Commlanon Faster. |

p
M = 1 U] 740 ¢ s « 3908}
Awninge My pu
St Dennin e b
Design M- 13960 i
+ Dhack

B Hep

Dhesbgn Summary

3 5W-1 Thickness Devign Saftwars - [Palmdale Airport Tasiway €]

Pavement Design Detail Report /

SW-1 Thickness Design Software version 1.0
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Chapter 7

General Aviation Airports

Pavement design for the nation’s 538 primary air_carrier airports must deal with
heavy commercial jets (gross loads in excess of 60,000 Ib.) that impose demanding
loads on airfield pavements. There is a vast secondary network of thousands of
smaller airports that allow the nation’s fleet of general aviation (GA) aircraft to serve
local communities throughout the country. These GA aircraft are generally smaller,
have gross weights less than 60,000 Ib., and place a different set of demands on the
pavement systems at GA airports. The GAO describes general aviation as follows:

“General aviation covers all civil aircraft not flown by commercial airlines
or the military. Its tens of thousands of aircraft include corporate jets,
medical-evacuation helicopters, and airplanes owned by recreational
fliers and hobbyists. Three out of every four takeoffs and landings in the
United States belong to general aviation flights.”  (GAO, 2001)

The Asphalt Institute method of thickness design for GA airports is covered in detail
in 1S-154, Thickness Design—Asphalt Pavements for General Aviation. This
method, which has been automated by SW-1, requires familiar input values as other
Al methods: traffic, subgrade stiffness, and pavement cross section. Design of
overlay pavements is accommodated by “borrowing” the effective thickness
procedure from MS-17. These topics are described in further detail in this chapter.

A SW-1 Thickness Design Software - [Palmdale Airport GA Parking Apron]

Fie Help
Project Definition | Traffic | Subgrade | Cross Section | Results |
Project: Palmdale Aiport GA Parking Apron
New | Copy | Delete | Rename |
(e AT Example Problem—See SW-1 User's Guide Chapter 7 LLLEA S Customan]
Pavement Use Project Type

Aircraft @ New Pavement Design (IS-154)

" Air Carrier Airports

(e General Aviation Airports

Cars and Trucks
" Overlay
(" Highways, Roadways and Streets

(" Parking Lots, Dri ys. and Service Stati

Heavy Equipment

Port Facilities and Heavy Wheel Load
Applications
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Traffic

44

Note: The simplified thickness design approach in the general aviation airports
procedure is limited to asphalt pavements designed to support airplanes having
gross weights up to 60,000 Ib. If aircraft gross weights in excess of 60,000 Ib. are
expected, use the method for Air Carrier Airports.

The primary traffic input in this method is the selection of the mix of aircraft in use at
a particular airport. From the selected aircraft, SW-1 assigns the aircraft with the
highest gross take-off weight as the critical aircraft and uses its gross weight to
solve for the pavement design thickness.

A SW-1 Thickness Design Software - [Palmdale Airport GA Parking Apron] E@g|
Fie Help
Project Definition | Traffic | Subgrade | Cross Section | Results |
General Aviation Traffic Information

Aircraft Type Takeoff Weight (Ib) [Selected B

Beech Aircraft Beechjet 15780 E

Beech Aircraft Bonanza/33/36 3850

Beech Aircraft C99/Airiner 11300 O

Beech Aircraft Duke/ABD G775 [m] J

Beech Aircraft King Air/C304 650 O

Beech Aircraft King Air/F90-1 10960

Beech Aircraft Musketeer/23 2450 [m]

Beech Aircraft Queen Air/ABS 7700 O

Beech Aircraft Queen Air/AB0 8800 [m]

Beech Aircraft Starship 12500 [m]

Beech Aircraft Super King Air 300 14000 [m]

Beech Aircraft Super King Air 6200 12500 [m]

Beech Aircraft Turbo/18 10280 [m]

Beech Aircraft Wolpar-Turboliner 11600 [m]

Bellanca Citabria/7 1650 [m]

Bellanca Super Viking 3325 [m]

Britizh Aerospace 700 24800 [m]

British Aerospace 800 27400 [m]

Britizh Asrospace Intercity 748 46500 [m]

#_|British Aeraspace Jetstream 31 15212 m| ﬂ
Clear
User Defined General Aviation
‘O(herAlmraﬂ (User's Option) 0 o

To Input Aircraft and Identify the Critical Aircraft

1. On the traffic tab, scroll down the list of aircraft to find the aircraft that operate on
the project pavement. Check all that apply.

2. If you do not find a particular aircraft on the list, you can enter it as a User
Defined Aircraft. It is important that you accurately input the maximum take-off
weight of the aircraft in pounds.

3. When you are finished entering aircraft, click Back, Next or select another tab.
SW-1 will find the critical aircraft and use its gross weight in the remaining
calculations.

Note: A shortcut is to check only the box for the critical aircraft—if it already known.




Subgrade

The GA airport design method uses the standard inputs for subgrade stiffness as
described in Subgrade on p. 33.

Cross Section

In the SW-1 program, you have the ability to select from three general pavement
cross-sections: 1) Full-Depth Asphalt, 2) two inches of HMA over a layer of
Emulsified Asphalt Base, and 3) HMA over a layer of six inches of Untreated
Aggregate Base.

T SW-1 Thickness Design Software - [Palmdale Airport GA Parking Apron]

File Help

Desired Design Cross Section

(" Full Depth Asphalt
" Emulsified Asphalt Base below 2 inches Hot Mix Asphalt

& Hot Mix Asphalt over 6 inches Untreated Aggregate Base
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Example Problem—Palmdale Airport GA Parking Apron

Problem: The Palmdale Airport is planning to construct a
new parking apron to support additional general aviation
aircraft. The pavement is to be designed for the aircraft
shown in Table 6. The Geotechnical Engineer reports
that a Design Resilient Modulus for the silty-sand
subgrade is 8,500 psi. What is the recommended HMA
thickness for a pavement section that incorporates a 6-
inch granular base course?

Solution

1. From the Problem Definition screen

create a new project record or select an S B —

existing project record from the drop- el o

down list. — e Pt 49459
2. Select General Aviation Airports under T -

Pavement Use and select New o e

Pavement Design (1S-154) under e

Project Type to define the project.

% 5w-1 Thickness Design Softwars - [Falmdale Airport GA Parking Apren]

ot Facibtins naed Homey Wheel Loag
Applcatons

Table 6—GA Aircraft Listing
for Palmdale Airport
Aircraft

Beech Bonanza
Beech King Air/F90-1
Cessna 172

Cessna Citation IlI
Learjet Century Il 35
Piper Chieftain

3. Click on the Traffic tab to reveal the [N

Projert Definman | Trame | Ssograse | Cross Ssctien | Resuns |

Traffic screen. Select each of the six

Genesal Aviation Trallie

[Tkl Wrigghd 1) [Sulected |

aircraft types listed in Table 6 by clicking | =
the appropriate box in the General -
Aviation Traffic Information table. You
may have to scroll up or down to find
them.

4. Click on the Subgrade tab to reveal the [
Subgrade screen. Select M, as the Type

of Strength Measure and enter a single | "=™= -

value of 8,500 psi. e

Project Definman | Trame | Susgrase | Cross Sectien | Resuns |

Finsdinn Mndubss Caicaating

Flscommaned Dusiqn Sunsgih Peicsmiin W =

g = =
S Dentsn i b

Design Mp: 8500 P
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5. Click on the Cross-Section tab to reveal
the Cross-Section screen. Select HMA
over 6 inches of Untreated Aggregate
Base as the Desired Design Cross-
Section.

6. Click on the Results tab to calculate
results and reveal the Design Summary.
For this problem the calculated HMA
thickness is 5.6 inches.

#3 5W-1 Thickness Design Softwars - [Palmdale Airport GA Parking 4pran]
Fe tep
Project Detinman | Trame | Sutgrase | Cross Sactios | Resuns |

Dasund Dussga Crass Section

Full Dop Asphal
Lmslsind AspAnl Nase bebew 7 ischas Hor Mis Aspdan

ot Mt Asphal oves § sches Unisated Agqregats lase

#3 5W-1 Thickness Design Softwars - [Palmdale Airport GA Parking 4pran]
Fe tep
Projecs Datinman | Tramme | Subgrase | Cross Saction | Resunms |
Design Summary
T v ——
Resilbent Modulus (M)

NiA

Design M, (psi) 8,300
Pavement Materiak

. Hot Mix Asphalt over 6 inches Ustrested
Desired Cross Section: 4

Aggregate Base
Design Pavement Cross Section
Required Thickness of New HMA 5.6
Pavement (in @
Fnssh Flapart
fummary Dutnil o,
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Chapter 8

Highways, Roads, and Streets

This chapter covers the elements of new pavement design for highways, roads, and streets.
Following chapters cover overlay design, two-phase design, planned staged construction,
and simplified methods, all methods that applicable to highways, roadways, and streets.

Climate

Temperature affects the response of asphalt materials to loading, and consequently affects
the critical strain values calculated under traffic loading. Freezing and thawing conditions
also affect the stiffness of supporting unbound base and subgrade materials. More
information is provided in Climate on p. 29

For highway pavement design, three different MAAT classifications are available.

Select the desired MAAT by clicking the appropriate radial button

A SW-1 Thickness Design Software - [US 195 Harper to Ironsides] QEB|
Fie Help

Environmental Conditions
(for more information, see MS-1, Chapter Il

Mean Annual Air

Temperature (MAAT) v S

Note:

@ <45°F Yes Mean Annual Air Ternperature (MAAT) was used
o characterize the environmental conditions

applicable to the continental United States. For
detailed information on the development of the

. MAAT regions. see Asphalt Institute Research
¢~ B0°F Possible Report RR 82-2 "Research and Development of
The Asphalt Institute's Thickness Design Manual
(ME-1) Minth Edition."

~ = 75°F No

Traffic

In the SW-1 program, mixed highway and roadway traffic is represented by the number of
equivalent 18 kip single-axle load applications, commonly referred as ESAL.
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FA SW-1 Thickness Design Software - [US 195 Harper to Ironsides]
Fie Help
Project Definition | Climate \ Traffic. ‘ Subgrade | Cross Section | Results |
Design Period (years) 20
Design Lane Factor 0.5 Annual Growth Rate (%) 4
Initial Average Annual Daily Classification
= 1500
Traffic (AADT) & Rural  Urban
Percent Trucks Eti}
- Percent of Truck
Vehicle Type Traffic Factor
Single Unit Trucks
?2-Axle, 4-Tire 25 ,Wi Calculated Equivalent Single Axde Load (ESAL)
2-Axle, 6-Tire 18 0.3 Initial Year ESAL 83,198
Design Period ESAL
3-Axle or More 7 0.08 9 2477636
Multiple Unit Trucks
4 Axle or Fewer [ [0:84
5-Axle 38 1.36
6-Axle or More 5 1.63
100%

The number of ESALs expected during a given period of time is a primary concern. The
SW-1 traffic tab allows you to estimate the number of ESALs expected on a highway facility
over a period of time, using the following equation:

> = (number of vehicles in each weight class) * (Truck Factor)

ESAL is calculated by multiplying the number of vehicles in each weight class by the
appropriate Truck Factor and summing the products.

Note: The typical Truck Factors were calculated from data summarized by the Federal
Highway Administration in 1985.

Subgrade

The method for highways, roads, and streets uses the standard inputs for subgrade
stiffness as described in Subgrade on p. 33.
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Cross-Section

¥ sW-1 Thickness Design Software - [US 195 Harper to Ironsides]

Fie Help
Project Definition | Climate | Traffic | Subgrade || Gross Section || Results |
Select Cross-Section Type
 Typel " Type 2 @ Type 3  Type 4  Type b5 " Typeb
FulF-Depth HiA over Emulsified Asphalt
Asphalt HMA over Untreated Aggregate Base (AGG) Bass EE]
HMA HMA
HMA LR HMA HMA
6 in.
. in. EB
AGG 12 in. s =B
AGG
Subgrade Subgrade FiL
Subgrade (A AGG
Subgrade
Subgrade Subgrade

The Cross-section screen allows the user to specify the combination of materials to be used
in the pavement section. There are six cross-section types available in SW-1 as shown in

the following table. For types 5 and 6, the user is essentially solving for EB thickness.

Type

Category

Description

Design
Objective

Full-Depth
Asphalt

Hot-mix asphalt (HMA) is employed for all courses above
the subgrade or improved subgrade

HMA

HMA over
Aggregate
Base

HMA surface course with a 6-inch thick base layer of
unbound aggregate. Minimum HMA thickness is 3 to 4
inches depending on traffic.*

HMA

HMA surface course with a 12-inch thick base layer of
unbound aggregate. Minimum HMA thickness is 3 to 4
inches depending on traffic.*

HMA

HMA surface course with a user-defined base layer of
unbound aggregate. Aggregate base thickness can vary
from 4 to 18 inches.

HMA

HMA over

Emulsified
Base

HMA is employed as the surface course with emulsified
base (EB) used as the base material. SW-1 solves for the
total thickness required and employs a minimum HMA
layer thickness of 2 or 3 inches depending on traffic
volume.*

EB

HMA is employed as the surface course with emulsified
base (EB) used as base layer over a user-defined layer
of unbound aggregate that can vary from 4 to 18 inches.
SW-1 solves for the total thickness required and employs a
minimum HMA layer thickness of 2 or 3 inches depending
on traffic volume.*

EB

* The user is referred to MS-1 for further detail on the relationship between traffic levels and
minimum HMA thicknesses for aggregate base and emulsified base problems.
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Example Problem—US Route 195—Harper to Ironsides

52

Problem: The Oregon DOT is planning to
construct a new two-lane highway between
the towns of Harper and Ironsides in the rural
eastern part of the state. The climate
consists of cold, harsh winters coupled with
hot dry summers (MAAT = 45 °F). Freeze-
thaw must be accounted for in any pavement
design. Laboratory CBR tests on material
from five locations along the route are
reported as follows: 22, 25, 18, 27, and 16.
(The ODOT pavement designer prefers to
use a special CBR Correlation Factor, f =
1,350). Initial traffic volume is only 1,500
AADT, but traffic growth is expected to be
rapid—4 percent annually. Trucks account
for 40 percent of the ftraffic on this rural
stretch of highway and the truck class
percentages are shown in Table 7. Use a
design factor of 0.5 and assume a 20-year
design period. What is the recommended
HMA thickness for a pavement section that
incorporates a 12-inch granular base
course?

Solution:

1. Click New and create a new project
record. Select a Pavement Use of
Highways, Roadways, and Streets and

select New Pavement Design (MS-1) as
the Project Type.

2. Click Next.

3. On the Climate screen, select MAAT <
45 °F,

4. Click Next.

Table 7—Truck Percentages for US 195

e
2-Axle, 4-Tire 25

Single Unit 2-Axle, 6-Tire 18
3-Axle or More 7
4-Axle or Fewer 7

Multiple Unit | 5-Axle 38
6-Axle or More 5

3 5w-1 Thickness Design Software - [US 155 Harper to Ironsides]

Fe teb

Propecs Detinman | Cimans | Trafhe | Subgrage | Cross Secsen | Resutts |

Projeot:

Parbing Lots. Drnvorways. aed Serice Glalioes
greves

ot Facibtios nnd Hamsy Wheet Load
Applcatons

 Norw Pavamant Dussgn (W5-1)

Torts-Phass Dusige (WS-1+ ME-17). Effacivs
Thichnes Overiay

Sampiitied Cusign Mutiod (15161

Adbvancod Siruciesl Aaalysis [AMA}

3 5w-1 Thickness Design Software - [US 155 Harper to Ironsides]

Fe teb

Propecs Definman | Camats | Trafhe | Subgrage | Cross Secsen | Resutts |

Ermmunmumnt al Condaions.
(i more informasion, see MS-1, Chapter i)

e Annual Air

Temparsturm (MAAT) Frust Effects

& < 45°F Yes

60°F Fussible

= T5F Ho




On the Traffic screen, enter the data from
the Example Problem statement and the
truck class percentages from Table 7.
The Design Period ESAL should show
2,477,636 ESALs over the expected 20-
year life.

Click Next.

On the Subgrade screen, select CBR for
the Type of Strength Measure and
enter the five CBR values as shown.
Make sure the Details box is checked
and enter the special correlation factor in
the CBR Correlation Factor, f box. See
that SW-1 has calculated a value of
21,995 psi.

Click Next.
On the Cross-Section screen, select the
Type 3 radial button corresponding to an

aggregate base thickness of 12 inches.

10. Click Next.

11.View the calculated HMA design
thickness of 6.3 inches.

12. Click Finish to reveal the screen tabs.

3 5W-1 Thickness Design Software - [UIS 195 Harper to Iroesides]
Fe tep
Project Datnman | Chmats | Trattic | Subgrage | Crows Secesn | Resuits |

Dasiga Lana Fucior

Il Avernge Asmesl Dy
Traftec (ASDT)

Purcest Trucks

Design Pessed fynars]

sl Grow Piate (%)

Clnssticason

& iaral

Fercom ol

Vibicte Type e

Track
Faacrar

Singln Uan Trucks

-ate, 4 Tiw

Tt b Tin

p—

Maltiphe Linst Trucks

4 Ao o Fewor
e

-Aale ur Mars

Calculnted [ quivalun Sagle Ads Lond (£5AL)

Initial Year ESAL Five
Dusign Perlod ESAL [ uiiin

Fe e

Type ol Sunngh Monsun

Bubgrade CBR wabios
| vane

3 5W-1 Thickness Design Software - [US 195 Harper o Iroesides]

Project Detinmon | Chmate | Trafc | fubgrage | Cross Secuen | Resuits |

Flasdion Modubss Calcaatios
Design ESAL
pr—
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A My
sadnd Diranten

Design M-

[reepr—

B Hep

Subeet Crovs-Suctios Typn

3 5W-1 Thickness Design Software - [UIS 195 Harper to Iroesides]

Propecs Definman | Cimans | Trafhe | Subgrage | Cross Secsen | Resutts |

& Typel Type 2 Type 1 Typa &
Fub-Dwph HMA D Uinremnd Agcregee flase (AL
A HMA HMA HMA
6 in,
n.
AGG 12 in AGG
Subgrade o
Sebgrade 1)
Subigrade
- ——

Type § Typa &
s
e 4im.
HMA A
EB ER
Subgraile in.
AGG
Subgradn

3 5W-1 Thickness Design Software - [US 195 Harper o Iroesides]

Fe e

Design Summary

Sabgrade M, (psi)

User Jahn Duval

HMA Thickness (is)

Aggregate Base Thickness (in) 120

Project Definman | Clmain | Trafhe | Subgrage | Cross Secsan | Resuns |

Date 8162008

fou

Design Traffic (ESAL): 2477636

63

st Flapart

& Summary
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Chapter 9

Overlay Design

Design of HMA overlays is based on either the effective thickness or the deflection method
as detailed in Asphalt Institute Manual MS-17.

Effective Thickness Method

The effective thickness procedure for structural evaluation and overlay design is based on
the concept that pavements deteriorate. In other words, their service life has been reduced
after exposure to traffic for extended periods of time. In effect, a pavement “uses” part of its
total life as a result of load repetitions imposed by traffic. By the time distress conditions
appear on the surface of the pavement a certain amount of the useful life of the pavement
has been used and must be accounted for in the design process. At the same time, the

‘remaining life” of the existing pavement can be utilized in designing the pavement for
future conditions.

FA SW-1 Thickness Design Software - [Wolf Creek Road] g@g|
Fie Help

Project Definition | Traffic | Subgrade | Overlay Design | Results |

Project:  [wolfCresk Road Ed|

New | Copy | Delete | Rename|

Description:

Example Problem—Ses SW-1 User's Guide Chapter 3 BLLEEN S Customan]

Pavement Use Project Type

Aircraft " New Pavement Design (M5-1)

" Air Carrier Airport
7 BT (AT Two-Phase Design (MS-1+ MS-17), Effective
" General Aviation Airports WUIESGES Gl

i~ Planned Staged Construction

Cars and Trucks
@ Overlay
@ Highways. Roadways and Streets
@ MS-17, Effective Thickness

" MS-17. Maximum Deflecti
" Parking Lots, Driveways, and Service Stations aamum Deflection

Heavy Equipment (~ Simplified Design Method (15-1681)
~ PortFacilities and Heavy Wheel Load " Advanced Structural Analysis (DAMA)
Applications

The procedure assumes that as a pavement uses part of its total life, it behaves as if it were
an increasingly thinner pavement, i.e., its effective thickness becomes less and less to
account for the expended portion of the total life of the pavement.
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To calculate the effective thickness of an existing pavement, it is necessary to know the
composition, thickness and condition of each pavement layer. It is also necessary to obtain
an estimate of future traffic (ESALs) following the HMA overlay. Finally, the thickness
computation of a new, full-depth asphalt pavement is based on identified subgrade strength
and ESALs. The overlay thickness is the difference between the thickness for a new
pavement and the effective thickness of the existing pavement.

Estimating Effective Thickness from Pavement Condition

With this method, the condition of the pavement layers is determined and appropriate
conversion factors are selected from Table 8-1. The effective thickness of each layer is the
product of the actual thickness of each layer and the appropriate conversion factor. The
effective thickness of the total pavement structure is the sum of the effective thickness
values of all layers, or:

Te=2 TG
where:

T, = effective thickness

T;= actual thickness of each layer

C, = conversion factor

Available equivalency performance data on materials are insufficient to set specific
conversion factors. Thus, the conversion factors in Table 8, encompassing most paving
materials, are in some degree subjective. Although the ranges in values shown are based

on a subjective analysis, experience has shown that they are reasonable and useful for
overlay design.

Calculation of Overlay Thickness

The effective thickness overlay design procedure given in SW-1 makes use of the following
relationship:

To = Tn - Te
where:

T, = Thickness of overlay

T, = Thickness that a new pavement (after overlay) would require for expected traffic and
subgrade conditions.

Te = Effective thickness of the existing pavement structure



Table 8—Conversion Factors for Effective Thickness Method

Conversion Factors for Converting Thickness of Existing Pavement Components to Effective

Thickness (Te) (After MS-17 Table 8-1)

Classification

Description of Material

Conversion
Factor

a

Native subgrade in all cases.

b

Improved Subgrade - predominately granular materials - may contain some
silt and clay but have P.I. of 10 or less.

Lime treated subgrade constructed from high plasticity soils - P.l. greater
than 10

0.0

Granular subbase or base—reasonably well-graded hard aggregates with
some plastic fines and CBR not less than 20. Use upper part of range if P.1.
is 6 or less; lower part of range if P.l. is more than 6.

0.1-0.2

Cement or lime-fly-ash stabilized subbases and bases constructed from low
plasticity soils - P.l. of 10 or less.

0.2-0.3

Emulsified or cutback asphalt surfaces and bases that show extensive
cracking, considerable raveling or aggregate degradation, appreciable
deformation in the wheel paths, and lack of stability.

Portland cement concrete pavements (including those under asphalt
surfaces) that have been broken into small pieces (2 feet or less in
maximum dimension [0.6 meters]) prior to overlay construction. Use upper
part of range when subbase is present; lower part of range when slab is on
subgrade.

Cement or lime-fly-ash stabilized bases that have developed pattern
cracking, as shown by reflected surface cracks. Use upper part of range
when cracks are narrow and tight; lower part of range with wide cracks,
pumping or evidence of instability.

0.3-0.5

Rubblization

0.3-0.6

Crack/Break and Seat (when unstabilized base is present, use lower end of
range. When stabilized base is present, use upper end of range.)

0.5-0.7

\

Asphalt concrete surface and base that exhibit appreciable cracking and
crack patterns.

Emulsified or cutback asphalt surface and base courses that, although
remain stable, exhibit some fine cracking, raveling, or aggregate
degradation, and slight deformation in the wheel paths.

Appreciably cracked and faulted portland cement concrete (PCC) pavement
(including those previously overlaid with HMA) that cannot be effectively
undersealed. Slab fragments that range in size from 1 to 4 square meters,
and have been well seated on the subgrade by heavy pneumatic-tired
rolling.

0.5-0.7

Vil

HMA surfaces and bases that exhibit some fine cracking; have small
intermittent cracking patterns; and have slight deformation in the wheel
paths but remain stable

Emulsified or cutback asphalt surface and bases that are stable, generally
uncracked, show no bleeding, and exhibit little deformation in the wheel
paths.

Portland cement concrete pavements (including those under HMA) that are
stable and undersealed, have some cracking but contain no pieces smaller
than about one square meter.

0.7-0.9

VI

Hot-mix asphalt, including HMA base, generally uncracked and with little
deformation in the wheel paths.

Portland cement concrete base, under HMA surface, that is stable, non-
pumping and exhibits little reflected surface cracking.

09-1.0

57



Example Problem—Wolf Creek Road
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Problem: The Lane County Public Works
Department is planning to overlay a two-lane
rural county road between the towns of
Cougar and Westfir high in the Cascade
mountain range. The existing road is
constructed of 3 inches HMA over 6 inches
aggregate base. Subgrade soils along the
route are consistent with M, = 7,000 psi. The
pavement design consultant does not have
access to any deflection data and decides to
use the Effective Thickness method for
overlay design. A pavement condition survey
reveals that the existing HMA surface shows
some light cracking and minor wheel path
rutting. Traffic volume is 1,100 AADT
growing at 1.5 percent annually. Trucks
account for 22 percent of the traffic with the
truck class percentages shown in Table 9.
Use a design factor of 0.5 and assume a 20-
year design period. What is the
recommended HMA overlay thickness?

Solution:

1. Click New and create a new project
record. Select a Pavement Use of
Highways, Roadways, and Streets and
select Overlay as the Project Type.
Check the box next to MS-17, Effective
Thickness

2. Click Next.

3. On the Traffic screen, enter the data from
the Example Problem statement and the
truck class percentages from Table 9.

4. Click Next.

Table 9—Truck Percentages for WCR

e
2-Axle, 4-Tire 24

Single Unit 2-Axle, 6-Tire 8
3-Axle or More 6
4-Axle or Fewer 6

Multiple Unit | 5-Axle 52
6-Axle or More 4
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10.

On the Subgrade tab select M, for the
Type of Strength Measure and enter
the single M, value.

Click Next.

On the Overlay screen, enter the F-
Factor and Thickness of the existing
section. (In this case, the consultant
decides to use F-Factors of 0.15 for
aggregate base and 0.8 for the existing
HMA, respectively.) Note that SW-1
calculates and displays the effective
thickness of individual layers and that of
the total existing section.

Click Next.

View the calculated overlay design
thickness of 5.8 inches.

Click Finish to reveal the screen tabs
and perform comparative analyses.

3 5W-1 Thickness Devign Saftwars - [Wolf Creek Road]
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Maximum Deflection Method

60

The Asphalt Institute deflection-based design methods for flexible pavements and rigid
pavements have been established over many years of successful application. The method
is based on the analysis of Benkelman Beam data. In the maximum deflection method, you
can also use data from a dynamic or impulse load NDT device such as the Dynaflect, Road
Rater and falling weight deflectometer (FWD).

The deflection procedure for flexible pavements is an empirical method, which uses an
actual Representative Rebound Deflection (RRD) from the Benkelman Beam device, or an
equivalent RRD from dynamic or impulse nondestructive test device. The magnitude of the
deflection is an indicator of the structural capacity of the existing pavement and its ability to
accommodate future traffic loading. The deflection data is used to evaluate whether a
strengthening overlay is indeed necessary, and if so, to design the overlay thickness.
Overlay thickness is designed to reduce pavement deflections from a measured to a limiting
design RRD for varying traffic conditions.

As with flexible pavements, the rigid pavement deflection method is also empirically based,
whereby actual or equivalent RRDs are measured and compared to limiting values for
jointed and continuous reinforced concrete pavement.

Overlay Design Inputs

The maximum deflection overlay design procedure requires detailed information that is
covered in detail in Asphalt Institute Manual MS-17 “Asphalt Overlays for Highway and
Street Rehabilitation.” Readers are referred to MS-17 for details on this method.

F2 SW-1 Thickness Design Software - [OR 31 Paisley to Valley Falls] g@g|
Fie Help

Maximum Deflection Overlay Design Information

Type of Equipment Used To Measure Deflections [Dynatlect k3
Critical Period Adjustment Factor 1 Number [Deflection (mils)
1 23
Asphalt Concrete Overlay Modulus At 70°F ‘4004000 2 35
3 38
Total thick of existing asphalt c @in) ‘4 ] 4 32
5 28
Total thickness of untreated aggregate base (im) ‘E a B 3
7 40
Esti dp t surface p (4] 80 8 kL]
9 35
Estimated previous 5-day mean air temperature CF) g0, 10 36
Mean Pavement Temperature (W] ’7
Temperature Adjustment Factor (W3] ’7
Add Point Remove Point

Show Details




Deflection Points

The SW-1 program has the capability to conduct a deflection analysis using deflection
points acquired by four types of deflection equipment:

e Benkleman Beam

e Dynaflect

e Road Rater

e Falling Weight Deflectometer

Deflection data is entered manually in SW-1 after selecting the appropriate type of
equipment from the drop-down list.

Maximum Deflection Overlay Design Information
Type of Equipment Used To Measure Deflections: ‘Dynaﬂect ﬂ

Number_[Deflection (mils) |

1
2

3

4 ]

5 |28
B

7

8

9

1

=
w
=]

Add Point I Remove Point |

Once all the desired deflection points have been entered, overlay calculation is completed
by clicking on the Results tab.
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Example Problem—OR 31—Paisley to Valley Falls
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Problem: The Oregon DOT recently
conducted falling weight deflectometer
testing on a section of OR 31 between
Paisley and Valley Falls for the purpose of
overlay design using the Maximum Deflection
method. The existing road is constructed of
4 inches HMA over 8 inches aggregate base.
Traffic volume is 1,500 AADT growing at 2
percent annually. Trucks account for 28
percent of the traffic with the truck class
percentages shown in Table 10. FWD
deflection tests are shown in Table 11. Use
a stiffness of 400,000 psi for the modulus of
HMA at 70 °F.

Solution:

1. Click New and create a new project
record. Select a Pavement Use of
Highways, Roadways, and Streets and
select Overlay as the Project Type.
Check the box next to MS-17, Maximum
Deflection

2. Click Next.

3. On the Traffic screen, enter the data from
the Example Problem statement and the
truck class percentages from Table 10.

4. Click Next.

Table 10—Truck Percentages for OR 31

Truck Type gif:frf};
2-Axle, 4-Tire 30

Single Unit 2-Axle, 6-Tire 12
3-Axle or More 4
4-Axle or Fewer 6

Multiple Unit | 5-Axle 42
6-Axle or More 6

Table 11—Deflection Points for OR 31

Test | Deflection | Test | Deflection
No. (mil) No. (mil)

1 23 6 34

2 35 7 40

3 38 8 39

4 32 9 35

5 28 10 36
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5. On the Overlay Design screen select
enter the required information. Select
FWD as the Type of Equipment and
begin entering individual deflection
points. Use the Add Point and Remove
Point buttons to adjust the number of
rows available for deflection point data

6. Click Next.

7. On the Results screen, view the
calculated overlay design thickness of 4
inches.

8. Click Finish to reveal the screen tabs
and perform comparative analyses.
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Two-Phase Design

SW-1 includes the capability to design initial construction and subsequent rehabilitation
over extended analysis periods. This capability is especially important when developing
design alternatives and comparing life-cycle costs over time. Two-phase design uses the
procedures detailed in MS-1 and MS-17 coupled into a single design effort.

Note: Two-phase design differs significantly in concept from Planned Staged Construction,
which is discussed in the next chapter of this User's Guide.

The primary difference between a two-phased design problem and New Pavement Design
in a single stage is that an analysis period must be established. The analysis period must
be equal to or longer than the structural design period and is typically between 30 and 40
years. See Figure 4 for a visual depiction of this concept.

K‘ Overlay

Pavement Condition

Terminal Serviceability

<&
<

Design Period (Phase I) N Phase Il

Analysis Period (Phase | + 1I)

A

Y

A
Y

Time
Figure 4—Two-Phase Desigh Concept
The design inputs for a two-phase design are the same as those for traditional design of
new pavements and overlays. Climate, traffic, and subgrade inputs must be entered along

with cross-section and overlay conversion factors. The following example problem
illustrates the concept.
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Example Problem—Mill Plain Boulevard

Problem: The City of Vancouver is planning Table 12—Truck Percentages for MPB
to reconstruct Mill Plain Boulevard using a

two-phase design using Full-Depth Asphalt. | Truck Type I?ercef?t
The design period is 20 years and the , of Traffic
analysis period is 40 years. Mill Plain Blvd. 2-Axle, 4-Tire 63
has four traffic lanes (two in each direction). | Single Unit | 2-Axle, 6-Tire 12
Use a design lane factor of 0.4. Initial AADT 3-Axle or More 4

is 5,000 with 8 percent trucks. Truck 4-Axle or Fewer 2
classifications are shown in Table 12. Traffic | \yitiple Unit | 5-Axle 18
growth is projected at 1.0 percent annually in 6-Axle or More 1
this urban area. The MAAT for Vancouver is

approximately 60°F and the subgrade soll
resilient modulus has been established as
10,000 psi. What is the recommended
pavement thickness for initial construction
and the overlay?

Solution:

1. Click New and create a new project [EEEEErEEIEIE
record. Select a Pavement Use of | o s i oo 1|

Project: it Fuan boieo

Highways, Roadways, and Streets and N
select Two-Phase Design (MS-1 + MS- i e e
17) as the Project Type. e s

2. Click Next. o el i

Padking Lot Dvbvoway. asd Seevice Blasioss
ey [p——————

Fon Fachtios and Homvy Wheel | oad Advanced Giucteenl Asahess [DAMA}
Appkcasons

3. On the Climate screen, select MAAT = 60°F

4. Click Next.
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On the Traffic screen, enter the data from
the Example Problem statement and the
truck class percentages from Table 12.
The Design Period ESALs are calculated
to be 317,506 and the Remaining ESALs
are 387,385.

Click Next.

On the Subgrade screen, select Type of
Strength Measure as M; and enter
10,000 as the Subgrade M. value.

Click Next.

View the results for the Phase | Design
Summary to show a Full Depth Asphalt
thickness of 6.7 inches.

10. Click Next.
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11. On the Overlay Design screen note that
the existing HMA thickness is entered
under Phase | Full Depth Asphalt. Use
the default F-Factor of 0.6 for HMA. (A
table of F-Factors is available for
viewing.) Note the effective thickness of
the Phase | layer is 4.0 inches.

12. Click Next.

13. On the Results tab scroll down to see
that the calculated overlay thickness for
Phase Il is 2.9 inches.

14. Click Finish to reveal the screen tabs
and perform comparative analyses.
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Simplified Method

68

As its name states, the simplified method reduces some of the complexity of the standard
design method for highways, roadways, and streets. It is based on the procedure detailed
in Information Series No. 181 (1S-181).

The simplified method contains design information for a range of traffic conditions for urban
streets and rural highways, for difference subgrade conditions and for pavements
constructed of asphalt concrete, with emulsified asphalt mixtures, and with untreated
aggregate base and subbase materials. There is no consideration of environmental
conditions in the simplified method.

Traffic:

In the simplified method, traffic is broken down into six classes. Each class is associated
with a particular equivalent number of ESALs, the type of highway or street, and the
average daily number of heavy trucks expected on the facility during the design period. So,
rather than estimating the percentage of trucks and truck classes, the simplified method
asks the user to estimate traffic volume within a range.

¥ SW-1 Thickness Design Software - [SW 4th Ave--Jefferson to Burnside]

File Help

TRAFFIC CLASSIFICATIONS
(for more information see 15-181 Table I)
Traffic - No. of Heavy Trucks
Type of Street or Highwa
Class ESAL b 9 4 during Design Period
5| Parking Lots, Driveways
(| 5x 10 - Light traffic residential streets < 7.000
- Light traffic farm roads
o 104 - Residential Streets 7.000 - 15,000
- Rural farm & residential roads
- 105 - Urban minor collector streets 70,000 - 150,000
- Rural minor collector roads
- Urban minor arterial & light industrial streets 700,000 - 1,500,000
® IV 10 . . i . .500.
- Rural major collector roads & minor arterials
5 | .. e
= 9% 10 Urban freeways, expressways, & principal arterial highways 2 000,000 - 4,500,000
- Rural interstate & other principal highways
7 | - Urban interstate highways
® Uy . T 7.000,000 - 15,000,000
- Some industrial roads
* Whenever possible the traffic analysis and design procedures given in Asphalt Institute Manual MS-1 should
be used for roads and streets in traffic category IV and higher.

Subgrade Soils

In the simplified method, subgrade soil strength is assigned to one of three categories
based on the evaluation of an engineer knowledgeable with the local conditions. The three
categories are:

Poor Subgrade Soils: These soils become quite soft and plastic when wet. Included are
those soils having appreciable amounts of clay and fine silt. The coarser silts and sandy
loams also may exhibit poor bearing properties in areas where frost penetration into the
subgrade is a factor. Typical properties: M, = 4,500 psi, CBR = 3, and R-value = 6.



Medium Subgrade Soils: These soils retain a moderate degree of firmness under
adverse moisture conditions. Included are such soils as loams, silty sands, and sand-
gravels containing moderate amounts of clay and fine silt. Typical properties: M, =
12,000 psi, CBR =8, and R-value = 20.

Good to Excellent Subgrade Soils: Good subgrade soils retain a substantial amount of
their load-supporting capacity when wet. Included are the clean sands and sand-gravels
and soils free of detrimental amounts of plastic materials. Excellent subgrade soils are
unaffected by moisture or frost. They include clean and sharp sands and gravels,
particularly those that are well-graded. Typical properties: M, = 25,000 psi, CBR =17,
and R-value =43.

Base Materials

The simplified procedure includes designs for typical HMA surface and base courses,
emulsified asphalt bases, and untreated aggregate bases.

Emulsified Asphalt Mixes: For the emulsified mixes, the user can select from the following
mix types:

o Typel: Emulsified asphalt mixes made with processed dense-graded aggregates.
Plant mixing is required for the high quality, dense-graded Type | mixes in order to
obtain the controls necessary for uniform blending of aggregate and emulsified asphalt.

o Type ll: Emulsified asphalt mixes made with semi-processed, crusher-run, pit-run, or
bank-run aggregates. Plant or in-place mixing may be used to produce Type Il mixes.

e Type lll: Emulsified asphalt mixes made with sands or silty sands. Plant or in-place
mixing may be used to produce Type Il mixes.

FA SW-1 Thickness Design Software - [SW 4th Ave--Jefferson to Burnside]

Fie Hep

Subgrade Soils
® Poor Subgrade Soils
(" Medium Subgrade Soils

" Good to Excellent Subgrade Soils

Base Materials
" Asphalt Concrete Base
(@ Emulsified Asphalt Base
Mix Type
® Typel
" Typell
 Typelll

(" Untreated Aggregaie Base

Design Process

The design process is to simply select traffic, subgrade, and base material parameters from
the available options. For each combination of traffic level, subgrade strength and base
material type, SW-1 provides a design section.
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Example Problem—SW 4" Avenue—Jefferson to Burnside
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Problem: The City of Portland is planning to reconstruct SW 4™ Avenue from Jefferson

Street to Burnside Street.

Traffic volume on this minor urban arterial is moderate, with

approximately 1,000,000 ESALs expected over a 20-year design period. The subgrade

soils are native silts and silty clays that become soft when wet.

The city transportation

bureau is planning to use a plant-produced Type | emulsified asphalt base. What is the
recommended pavement section for reconstruction of this street?

Solution:

1. Click New and create a new project
record. Select a Pavement Use of
Highways, Roadways, and Streets and
select Simplified Method (1S-181) as the
Project Type.

2. Click Next.

3. On the Traffic Classification screen,
select Traffic Class IV for and ESAL
level 10°.

4. Click Next.

5. On the Subgrade screen, select Poor
Subgrade Soils. This agrees with the
description of silt and silty clay soils that
are susceptible to weakening in the
presence of water. Also select and
Emulsified Asphalt Base and Mix Type
| as the base material type.

6. Click Next.
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7. On the Results Screen, read the DeSIgn .!s"Thh:km!DnlgnMn-.‘uo-[.'-l\'lma-r-mrvmmammlﬂ]
Summary to find that the recommended | oo™ =™
pavement section is 8 inches of [ .

emulsified asphalt base and 2 inches of
HMA. Pt T ot e

lemn-See SW-1 User's Guide Chapter

Desigs Input Smmary
Traffi Ass! w

8. Click Finish to reveal the screen tabs. i ¥ M
Rase Emuilsified Asphalt Base, Type I
Subgrade Poor Subgrade Soils

Design Pavement Cross-section
It Concrete Surface(in) 20

ified Asghalt Base, Type |

Tosal Thickness (in} 10
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Chapter 10

Planned Staged Construction

Concept

Planned stage construction is the
construction of roads and streets by applying
successive layers of HMA according to a
predetermined time schedule. The design of
planned stage construction should not be
confused with the design of major
maintenance or the rehabilitation of existing
pavements. The procedure is based on the EAL
presumption that the second stage will be

constructed before the first stage shows Figure 5—Traditional Design
serious signs of distress.

100

DAMAGE FACTOR, D, %
o
(@]

To illustrate the approach, compare how
damage is accumulated in traditional design
methods as shown in Figure 5. As traffic is
applied to the pavement, damage is
accumulated until the damage factor is 100%
and the pavement has “failed.”

100 r ——————————
STAGE |

B == i
A !_‘ 2

|

In Figure 6, the concept of planned staged n, (n,+n2)ﬁ
construction is illustrated. In this method, EAL

damage is allowed to accumulate in the first
stage up to a damage factor of 60%. At this
point the second stage of the pavement
section is constructed and damage is allowed
to accumulate up to 100%.

DAMAGE FACTOR, D, %

Figure 6—Planned Staged Construction

Design Inputs

The primary design inputs in the planned staged construction method are the same as
those for other Asphalt Institute design methods: traffic
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Example Problem—Jasper Street Extension

Problem: The City of Springfield is Table 13—Truck Percentages
designing the Jasper Street Extension for

planned staged construction. The Stage 1 | Truck Type '?ercef?.t
design period will accumulate 60 percent of - of Traffic
total damage within 8 years with Stage 2 2-Axle, 4-Tire 70
accumulating the remaining 40 percent in 12 | Single Unit | 2-Axle, 6-Tire 12
years. |nitial AADT is expected to be 1,800 3-Axle or More 2
with 10 percent trucks. Truck classifications 4-Axle or Fewer 0
are shown in Table 13. Traffic growth is | \ytiple Unit | 5-Axle 16
projected at 5 percent annually in this fast- 6-Axle or More 0
growing rural area. The geotechnical

engineer reports the following CBR values: 7,
8, 10, 11, 10, 7, and 9. What is the
recommended pavement thickness for Stage
1 and Stage 2 construction?

Solution:

1. Click New and create a new project [AEEEEEEEENEEEErE
record. Select a Pavement Use of |™s = immi==
Highways, Roadways, and Streets and | ™ “. .
select Planned Staged Construction as e v g

the Project Type. Pamanin ot Ty

Mirw Pavvumamt Elussgn (W5-1)

Vot Phase Dusegn WS-+ ME-17). et
Thickneas Dverlay

2. Click Next. e nc T -

Oty

Pesbireg Luts, Deseirmays. s Serae Siabuns
ey Cqupment Sampistied Dunsgn Mutsad (15181}
Fron Facids and Hamy Wheet Load Addvnmcnd Suctuesd Aanhess (TTAMA]
Apphcatons

3. On the Traffic screen, enter the data [AEEEEEEEmEEErE
from the Example Problem statement | "™ ===
and the truck class percentages from [ ™™™ remell

Dasiga Lana Fucior 5 Ansunl Grows fiste (%)

Table 13. s A e

Traftec (ASDT) % fursd
Purcest Trucks

4. Click Next. — o .

Traic Faacrar
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Fhabe, 4 Tiow
Tt -Tiw Intisl Year ESAL i

Design Perlod ESAL 5555

Calesleied Equivalum Engle Axe Load (ESAL)

Pp—

uisingie Lint Trucks

A Al 1 Forar

Remaining ESAL
Tetsl ESAL

b or Mase.
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5. On the Subgrade screen, select Type of |

Strength Measure as CBR and enter |™ ™ ™™™
the CBR values from the problem [ "= .

statement. Note the Design Subgrade | == ssbion o
Resilient Modulus is 10,571 psi. DR e
= T B

6. Click Next.

—

Standad Devintion 3= P
Design M;: 10571 e

X 5w-1 Thickness Detign Software - [ Jasper Street Extnsion]

7. On the Results screen select view the [
Design Summary and scroll down to |7
see the Stage 1 and Stage 2 | |
construction thickness is 6.2 inches and P ormain

Project Name: Jaspe
1.7 inches, respectively. e e,
Pavement Use: General Roadway

Problem Type Staged Construction

8. Click Finish to reveal the screen tabs I
and perform comparative analyses.

Design Results
62

Required Thickness for Stage |
{im)

Required Thickness for Stage 2

Fuasuh apart
* Summany Dutnil o,
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Chapter 11

Heavy Wheel Load Applications

Design of HMA pavements for Port Facilities and Heavy Wheel Load applications is
based on the methods detailed in Asphalt Institute Manual MS-23, “Thickness
Design—Asphalt Pavements for Heavy Wheel Loads.” HMA overlays for heavy
wheel applications are designed using methods described in detail in Asphalt
Institute Manual MS-17, “Asphalt Overlays for Highway and Street Rehabilitation.”
This chapter covers new pavement design. For information on overlay design,
please see Chapter 9, Overlay Design.

Heavy wheel load vehicles include log-hauling trucks, dump-body haulers, fork-lift
trucks, straddle-carriers, rubber-tired hoists, and many special vehicles having as
few as four to as many as 12 or more tires. Heavy load vehicles can reach gross
vehicle weights in excess of 400 kips.

F SW-1 Thickness Design Software - [Warm Springs Log Sorting Yard]
Fie Help
Project Definition | Climate | Traffic | Subgrade | |

Project:
New | Copy | Delete | Rename |
EesErptiony Example Problem—5ee 5W-1 User's Guide Chapter 11
Pavement Use Project Type
Alrcraft @ New Pavement Design (M5-23)

i~ Air Carrier Airports

i~ General Aviation Airports

Cars and Trucks
(" Owverlay
(" Highways. Roadways and Streets

" Parking Lots. Dri ys. and Service Stati

Heavy Equipment

& Port Fﬂcililies and Heavy Wheel Load
Applications

In addition to vehicle and wheel load characteristics, the design thickness of the
asphalt pavement will depend on subgrade strength and climate in terms of the
mean annual air temperature (MAAT).
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Climate

For heavy wheel load applications, only two climate options are available. Both are
based on MAAT. Essentially, the choice is between a cold climate where the
subgrade is subjected to frost weakening and a warm climate with no freeze/thaw
concerns. Table 14 provides descriptions of the climate choices available for heavy
wheel load design.

Table 14—Climate Conditions for Heavy Wheel Load Designs

MAAT %'g:it\'/%g%g?)t'ons (30 Subgrade Conditions
VAVip;ﬁrca)c;r?:;hé:";nonths Subgrade subject to frost
55°F or temperatures 32°F or xi?ekaesnéggf.roﬁrzdx:;k
less below. Yearly average . o, :
daily temperature of 55°F Spring copdltlon to design
or less modulus in early fall.
Greater No freezing temperatures. rseunﬁg{:g?er;::nu;lg
than Yearly daily temperature h h y
550F above 55°F constant, t roughout year,
' at the design value.
FX sw-1 Thickness Design Software - [Warm Springs Log Sorting Yard] m@g|
File Hel
Pruject?:lefinitian |{ Ciimate”| Traffic | Subgrade | |
Mean Annual Air Temperature
(@ Less than 55°F (Freeze/Thaw Considered)
(" Greater than or equal to 55°F (No Freeze/Thaw)
Traffic Analysis
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For heavy wheel load applications, the design method in SW-1 treats three general
types of problems: single wheel load, dual wheel load, and multiple wheel load
problems.

For dual- and multiple-wheel vehicles, SW-1 uses a procedure that is based on the
concept that pavement design for multiple wheel vehicles can be accomplished by
first calculating an equivalent single wheel load. The equivalent single wheel load is
then used to select pavement thickness.

Note: As the name of this section implies, this method is intended for multiple-
wheel pavement applications other than highways, roadways, streets, and airports.




Dual and multiple wheel load problems are solved by determining equivalent single
wheel load. Single wheel load design problems are reasonably simple, requiring
only the magnitude of the wheel load (P), the tire-ground contact pressures (p), and
the contact area (a), and the number of load repetitions (n). Dual and multiple
wheel problems are more complicated, requiring additional wheel geometry data
information.

Note: Whether a design problem can be treated as a single wheel depends upon
the wheel spacing of the design vehicle. If wheels are separated by a distance
greater than eight times the radius of the circular loaded area, the problem may be
treated as a single wheel design problem. On the other hand, if the distance
between wheels is less than eight times the load radius, the problem should be
treated as a multiple wheel problem. Multiple wheel designs completed using
widely spaced wheels (greater than eight times the contact radius) will be
overly conservative.

FA SW-1 Thickness Design Software - [heavy wheel check] Q@@
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To set up a single-wheel load problem

1. On the Traffic tab, enter the contact pressure.

2. Enter the number of repetitions expected during the design life of the pavement.
3. In the Number of Wheel Loads box, enter 1.

4. Since only one wheel load is being considered, enter 0 for the X- and Y-

Coordinates in the Wheel Load Geometry table. Enter the magnitude of the
wheel load under the Load column.
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5. Since only one wheel load is being considered, enter 1 in the Number of
Computation Points box.

6. For a single wheel problem, enter 0 for the X- and Y-Coordinates in the
Computation Point Geometry table.

7. Select Next or Back or select another tab.

Multiple Wheel Loads

Multiple wheel problems require knowledge of the spacing between wheels and
axles. The wheel load geometry establishes the relative locations of the wheels
under consideration. The computation point geometry is used to layout the relative
location of the points to evaluate for damage. Normally, the computation points are
selected as those that accumulate the maximum amount of damage, although the
program can compute damage at any point given the relative geometry. Typically,
the computation points are directly under a wheel load, at the midpoint between two
dual wheels or two groups of wheels on an axle, and halfway between two axles.
See the screenshot below for an example layout showing wheel load and
computation point geometry for a multiple wheel problem.

-
7 sW-1 Thickness Design Software - [heavy wheel check]

Fie Help
Project Definition | Glimate | Traffic | Subgrade | Resuits |
Tire-Ground Contact Pressure (40-200 psi) |1l]5
Location Plot
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Wheel Load Geometry 20
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» |20 ] — 0000
Kl =1 I
10 L
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Computation Point G Ty 5
c ion Point_[X-Coordinate (in.) _[Y-Coordinate (in.) ]
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To set up a multiple-wheel load problem
1. On the Traffic tab, enter the contact pressure.
2. Enter the number of repetitions expected during the design life of the pavement.

3. Inthe Number of Wheel Loads box, enter the number of wheels acting together.



4. Enter the X- and Y-Coordinates in the Wheel Load Geometry table.
5. Enter the magnitude of the wheel load under the Load column.

6. Enter the Number of Computation Points box. In the table establish a label for
each computation point, such as A, B, C, etc.

7. Enter the X- and Y-Coordinates in the Computation Point Geometry table.

Note: Computation points can be assigned any position on the grid, but are
typically selected as the position where the highest strains are likely to occur.
Suggested points are directly under one wheel load, at the midpoint between dual
wheels or a group of two wheels, and at the center of a larger group of wheels. See
the example problem for further detail.

8. Select Next or Back or select another tab.

Subgrade

The method for heavy wheel loads uses the standard inputs for subgrade stiffness
as described in Subgrade on p. 33.

Results

Once the climate, traffic, and subgrade inputs have been completed, you simply
have to click Next to get to the Results tab. Please see the section entitled “Viewing
Results” on page 25 for more information on viewing and printing the results of your
Heavy Wheel Load design.

81



Example Problem—Warm Springs Log Sorting Yard

82

Problem: The Warm Springs Forest
Products Company is planning to
expand their log sorting yard due to
an increased volume of business.
The primary type of vehicle to be
used on the yard is a wheeled loader
with a grapple attachment for moving
and sorting logs. This vehicle has a
gross weight of 110,600 Ibs on four
wheels with a tire pressure of 65 psi.
The wheel load and computation
point geometry is shown in Figure 7.
Load repetitions are expected to
average 15 per hour for each of two 8
hour shifts per day. Assume 260
work days per year.

Subgrade resilient modulus testing
has been accomplished and the
following values reported: 21,000,
19,500, 18,700, and 19,400 psi.
What is the recommended pavement
thickness using a 20-year design life?

Solution:

1. Click New and create a new

project record. Select a
Pavement Use of Highways,
Roadways, and Streets and
select Planned Staged
Construction as the Project
Type.

2. Click Next.

3. On the Climate screen, select the
radial button for MAAT less than
55°F (Freeze/Thaw Considered)

4. Click Next.

(36)

_4[ H . }7_
(457)
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Figure 7—Wheel Load Geometry for
Heavy Wheeled Loader
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10.

On the Traffic screen, enter the
data from the Example Problem
statement including the wheel
load geometry and load
information. Note the number of
repetitions is calculated to be
1,248,000.

Click Next.

On the Subgrade screen, select
Type of Strength Measure as
CBR and enter the CBR values
from the problem statement. Note
the calculated design M, is 18,646
psi using a design subgrade value
of 85 percent.

Click Next.

On the Results screen select view
the Design Summary and scroll
down to see the recommended
design thickness is 17.8 inches.

Click Finish to reveal the screen
tabs and perform comparative
analyses.
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Chapter 12

Advanced Structural Analysis

General Description

SW-1 incorporates the DAMA module for advanced analysis of pavement
structures. DAMA was developed as a separate computer program by Dr. Matthew
Witczak at the University of Maryland to provide computational basis for developing
the structural design curves used in MS-1.

F2 SW-1 Thickness Design Software - [OR 203 Union to Medical Springs]
Fle Help

Project Definition | Climate | Traffic | Layers | Results |

Project: OR: 203 Union 1o

New | Copy | Delete | Rename |

(PRI Exarmple Prablem—See SW-1 User's Guide Chapter 12

Pavement Use Project Type

Aircraft i~ New Pavement Design (MS-1)

" Air Carrier Airport
1y (ERI Ly A eSS Two-Phase Design (MS-1+ MS-17), Effective
" General Aviation Airports LTSS Bl

i~ Planned Staged Construction

Cars and Trucks

" Overlay
® Highways. Roadways and Streets
(" Parking Lots. Driveways. and Service Stations
Heavy Equipment (" Simplified Design Method (15-181)
~ PortFacilities and Heavy Wheel Load @ Advanced Structural Analysis (DAMA)

Applications

DAMA is used to analyze a multi-layered elastic pavement structure by cumulative
damage techniques for a single or dual wheel load system. It can be used for
design purposes by analyzing several proposed structures. Many pavement
structures comprised of hot-mix asphalt (HMA), emulsified asphalt mixtures,
untreated aggregate materials, and subgrade soils can be analyzed provided the
maximum number of layers does not exceed five. The program can be used for
highway-type loads and for aircraft or other heavy-load vehicles.
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The Chevron N-Layer program, developed by Chevron Research Corporation, was
modified for dual loading conditions and used to obtain the required elastic solutions
within the pavement structure. The DAMA program routinely calculates selected
deflection and critical strain values at specified computational points along each
critical interface. The detailed report option is provided to allow the user to print all
the stresses, strains, and deflections at each layer interface. Critical interfaces are
defined as an interface where an asphalt stabilized material is above the interface
(several may exist in any given problem) or where a subgrade layer lies below the
interface. Three transverse computational points are automatically specified within
DAMA to fix the response locations. These computational points are at the center of
the one tire, at the edge of one tire, and at the midpoint of the dual-wheel system.
In so doing, the program automatically calculates the computational points along the
tire center-to-center bisector of the dual wheels. For single-wheel load solutions,
the dual tires are simply spaced a large distance apart.

Only the maximum strain at a given depth (interface) is used for the damage
computations. Pavement life based on fatigue cracking of asphalt stabilized layers
and subgrade deformation distress is determined using monthly cumulative damage
concepts. Predicted repetitions to failure for each distress mode and critical layer
are obtained from distress strain criteria (input variables) and the maximum strain
responses. Damage, computed on a monthly basis for a given monthly traffic
repetition input value, is accumulated up to a damage value of 1.0 for both distress
modes. The design life and number of load repetitions to failure are summarized for
cracking and deformation and the governing layer for the situation is noted.

Climate
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¥ X sw-1 Thickness Design Software - [OR 203 Union to Medical Springs]
Fle Help
Project Definition || Climate || Traffic | Layers | Results |

Envir I Conditi

Month [average Ar Temperatura (F)

January [255

Fobruary 35

HMarch [387

Apil 4.

Moy 524
ne 595

July |66

August 65.9

September 57.1

Ociobar 6.4

Mavermber |348
December %63

Environmental effects are characterized as input variables by mean monthly air
temperatures (MMAT) and variable monthly material moduli. The air temperature
data are used to account for the effect of temperature on moduli of asphalt mixtures.
The capability to account for monthly variations in unbound material properties
(base, subbase, or subgrade) allows one to assess the effects of freeze-thaw or



variable moisture conditions throughout a pavement life analysis having 12
individual periods (usually months).

The user is asked to provide mean average air temperatures for each of the months.
The temperatures used in developing MS-1 are as shown in Table 15:

Table 15—Example Mean Monthly Air Temperature Data

Month
. zZ m x x > pd — O] o =l > 0O
L < o < D -] L O | O | w
Climate (MAAT) S| eS|z 2(3]3 28824

New York (45°F) 14 | 25 | 24 | 27 | 42 | 48 | 61 | 69 | 65 | 55 | 48 | 41
S. Carolina (60°F) | 45|38 |43 |45 |56 |70 |78 |81 |78 |73 |58 |54
Arizona (75°F) 556 |61 6173190 9192|9393 |8 |72)|55

Another source of information is the set of tables in Appendix D of Asphalt Institute
MS-17, "Asphalt Overlays for Highway and Street Rehabilitation." These tables, list
the normal maximum and minimum temperatures for numerous cities throughout the
United States.

Asphalt Emulsion Mixes

For pavements using emulsified asphalt stabilized materials the program will also
account for the effects of modulus changes over any specified cure time. Because
of the added analytical complexities brought about by this material in the damage
computations, damage is computed on a monthly basis for the cure time (in months)
plus 12 months for all asphalt stabilized (HMA or asphalt emulsion) problems. For a
pavement structure not having an emulsified asphalt layer, the time of cure equals
zero and the number of months where damage (structural response) is calculated is
12. The yearly damage for the last 12-month analysis period is then used for all
future years until a damage of 1.0 is reached.

Traffic

The basic traffic inputs are shown in figure below. DAMA uses the tire contact
pressure, wheel load and space between wheels for duals along with the number of
repetitions per month to characterize the load configuration.
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Layers
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X sw-1 Thickness Design Software - [OR 203 Union to Medical Springs]
File Help
Project Definition | Climate | Traffic | Layers | Results |

Load Configuration

Contact Pressure (psi): o0
Wheel Load (Ibs): [asm
Repetitions per month: [z500
Wheel Load

(" Single Wheel
@ Dual Wheel

Opened to wraffic : June ¥

Emulsion cure time: [ (months)

Space Between Dual Wheels (in): 135

To enter Traffic Inputs in the Advanced DAMA Analysis

1.

In the Contact Pressure box enter the contact pressure in pounds per square
inch. This is the wheel load divided by contact area of tire (can be approximated
by inflation pressure).

In the Wheel Load box enter the wheel load in pounds. This is one-fourth of the
axle load if there are two sets of dual wheels on the axle. Alternatively, this is
one-half of axle load if there are only two wheels on the axle.

In the Repetitions per Month box enter the number of passes of the above wheel
configuration that occur monthly.

Select Single Wheel or Dual Wheel axle configuration

For dual wheel axle configurations, enter the center-to-center distance between
the dual wheels (typically, about 13.5 inches) in the Space Between Dual
Wheels box.

Click Back or Next or select another tab.

Note: These inputs are for typical wheel configurations for highway trucks, but
aircraft or other heavy dual or single wheel loads may also be entered here.

One of the major advantages of the DAMA program lies in its capability to
incorporate user-defined material and distress relationships within a monthly
damage scheme. Users have the option to input either direct laboratory modulus
responses for various design frequencies (load rate) and temperature for a specific
mix or to utilize a regression equation developed by the Asphalt Institute. This
equation predicts the elastic modulus, E*, which is a function of the percent passing



the No. 200 sieve size (P2q0), asphalt volume (V,), air voids (V,), asphalt cement
viscosity (n) and mix temperature (T).

On the Layers tab, the user creates the pavement cross-section and supplies
pertinent data for each layer. For asphalt concrete layers and aggregate bases, the
user has the option of entering the moduli directly or allowing DAMA to calculate the
moduli from the mix parameters or a stress-dependent equation, respectively. The
moduli of asphalt emulsified base and subgrade layers must be entered directly.

FX SW-1 Thickness Design Software - [OR 203 Union to Medical Springs] Q@l@
File Help
Project Definition | Climate | Traffic | Layers | Results |

Layer Definiti
Poissan's Modulus Caleulation
Layer No. |Material Typs B Thickness (in) 4240 Add Layer Above
T Acphal Concrete 035 7 Wix Froperties Add Layer Balow
[H Asphall Concrete >3 5 Wix Properties
N Suil Subgrade 1045 0 Direct Entry Remove Layer
Mix Properties —
% Air Voids |7, % Pass MNo. 200 |5
Frequency (Hz)[10
1,800
¥ Enter Volume Manually Abs. Vis. @ 140F (P |-
% Asphalt Volume [11. Kin. Vis. @ 275F (cS1)[260

Fatigue Model Coefficients

F [aa F [0004325 E. [3291
[ 1 2

Fy[pesa © P fasa I

Enter Evaluation Temperatures for Asphalt Layers l

To add a layer to the pavement structure

1. Place the cursor in one of the existing pavement layers above or below the
desired location of the new layer.

2. Choose Add Layer Above or Add Layer Below depending on the position of
the cursor relative to the desired location of the new layer.

To remove a layer from the pavement structure

1. Place the cursor in the existing pavement layer to be removed.

2. Choose Remove Layer.

To change the material type of a layer in the pavement structure

1. Select the target layer by placing the cursor in the existing pavement layer to be

modified in the Material Type column. A drop-down arrow should appear on the
right side of the Material Type column on the target row.

[ il R — )
£ SW-1 Thickness Design Software - [OR 203 Union to Medical Springs] L OX

File Help

Project Definition | Climate | Traffic | Layers | Results |

Layer Definiti
Poissan's <+ |Modulus Calculation
Layer Mo, |MmerwalType Ratio Thickness (in) Method Add Layer Above
1 |Asphalt Cancrete 03 7 M Properies A ey Bt |
|2 [l2sphalt Concrate) Mix Froperiiss —

3 1] Diredt Entry Remave Layer

sphalt Erulsion

Aggreqats Base

Soil Subgrace
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2. Click on the drop-down arrow to reveal a list of material types.

3. Select the desire material type from the drop-down list.

Note: There are some limitations in the DAMA module that should be kept in mind.
The number of layers is limited to five. The top layer must be asphalt concrete and
the bottom layer must be subgrade. Only one aggregate base layer is allowed and it
must be directly above subgrade layer.

To change the Poisson’s Ratio or layer thickness

1. Select the target layer by placing the cursor in the existing pavement layer to be
modified in the Poisson’s Ratio or Thickness columns.

Layer Definition

Poisson's Modulus Calculstion
Ratio Method

1 Asphalt Concrete 0.35 2 Mix Properties
b |2 |Asphalt Concrete ‘m |5 Mix Properties
3 Soil Subgrade 0.45 0 Direct Entry

Layer No. |Material Type

Thickness (in)

2. Enter the Poisson’s ratio or Thickness directly on the table.

Note: You are not required to enter a thickness value in the bottom subgrade layer
which is automatically assumed to have semi-infinite thickness by DAMA.

Note: Poisson's ratio is not a critical value within reasonable limits. The suggested
values for each layer type as shown in Table 16:

Table 16—Suggested Values for Poisson's Ratio

. Suggested
Material Type Poisson’s Ratio
Hot-Mix Asphalt 0.35
Asphalt Emulsion Base 0.35
Aggregate Base 0.35
Subgrade 0.45

To modify the mix properties in the HMA layer
1. Place the cursor in the row for an existing HMA pavement layer.

2. Using the mouse or keyboard, position the cursor in the cell of the table
containing the variable of interest. Modify the entry and move to the next cell.

The mix properties used in defining the dynamic modulus of hot-mix asphalt and for
adjusting the fatigue cracking pavement life equation can be entered on the Layers
tab.



Table 17—Mix Property Inputs for Advanced Structural Analysis

Must be estimated for both HMA and

Air Voids (Vy) AE layers (typically 3 to-10 %)

% Asphalt (Pp)

Must be estimated for both HMA and
asphalt emulsion layers (typically 9 to
13 % - if left O, will be calculated from
a given Py)

Asphalt Volume (Vp)

Needed for HMA layers (typically 2 to

% Passing #200 Sieve (P2o0) 8 %)

Needed for HMA layers
Frequency (Hz) 10 hz = 50 mph
2 hz =10 mph

Needed for HMA layers (will be used
() to calculate the viscosity at 70°F in
n poises x 10° for the DAMA equation)

Asphalt Binder Viscosity

In the Layer Material Properties Tab the Evaluation Range of Temperatures is used
to establish the monthly modulus-temperature relationship used in the structural
analysis and/or design.

A Evalua;iu_l; -TIEITI ;:eratures g@|

Ewvaluation
Temperature ('F)

10.

Results

Strain Values for Damage Analysis

In its original form, the Chevron N-Layer program yields elastic solutions to a single
uniform circular load. In order to have DAMA capable of more accurately analyzing
a dual wheel load (i.e. 18,000 Ib. single axle load), the original Chevron program
was modified to analyze computational points at the center of one tire (point 1), the
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edge of one tire (point 2), and at the midpoint of the dual wheels (point 3). All of
these points lie on the center-to-center bisector of the dual wheels.

For vertical subgrade strain (e,) computations, the individual strains due to each tire
(at the point in question) are directly added at any point along the subgrade
interface. There is no need in to specify the computational points.

For the principal tensile strain (e;) computations at the bottom of each asphalt
stabilized layer, the sum of tensile strains (radial, tangential and vertical) and the
difference of shear strains from the two tires at a given point are obtained to form a
strain tensor. Like the vertical subgrade strain analysis, computations are
automatically done at each critical interface at the three radial locations noted.

Damage Computations

Subgrade Deformation Damage

In DAMA, one of the two types of pavement distress considered is that of excessive
subgrade deformation leading to surface rutting. The criterion used to predict
repetitions to failure (Ny) for this mode of distress is based on the magnitude of the
vertical compressive subgrade strain (e,) using:

N; = dg X (ev)'d1 where: do and d; are empirical coefficients.

Currently, there are several different types of vertical subgrade strain criteria in the
literature. In order to allow DAMA to be as widely applicable as possible, the values
of do and d; are treated as input variables. As a result, DAMA can accept any
subgrade criteria of the form shown by the equation. The subgrade strain criterion
described by Santucci (1977 International Conference on Structural Design of
Asphalt Pavements) was used to develop design charts for MS-1. That relationship
used these constants:

do =0.1365x 10

d1 =4.477

Fatigue Cracking Damage

The other major form of distress analyzed by DAMA relates to fatigue cracking of
the asphalt-stabilized layer. Like subgrade deformation distress leading to rutting,
several pavement fatigue life criteria are available in the literature. In order to have
DAMA as flexible as possible, a special form of the fatigue equations for asphalt
stabilized materials was developed. ltis:

N; = fo x (10™) x (f; x e) x (E™5) with:

M =, X [(Vu/(Vy + Vp) - f§]

This failure equation should be viewed as having three distinct components:

1. Laboratory to field performance adjustment factor.



2. Mix adjustment factor.
3. Laboratory fatigue equation.

The factor f, is the "laboratory-to-field performance factor" and represents the
numeric value of the "shift" required to relate crack initiation to a "failure condition"
of the pavement due to cracking.

The mix adjustment factor, 10, is primarily used to adjust the fatigue life predictions
due to deviations in mix air voids, V,, and volume of asphalt, V,, from those used to
establish the laboratory fatigue curves.

The final component, (f; x e;) x (E™3), represents the laboratory fatigue curve. In

this portion, the form of the equation is such that a set of parallel multi-stiffness
(asphalt modulus) curves are obtained.
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Example Problem—OR 203—Union to Medical Springs

Problem: The Oregon DOT is designing a new Table 18—Temperature

pavement section for a particularly challenging and Subgrade M,
section of highway. Due to the high mountain

elevations, cool winter temperatures, and freeze- | ponth Temp | M
thaw action that take place, the SW-1 advanced (°F) | (psi)

structural analysis procedure will be used to analyze | January 25.5 | 35,600
one particular design scenario. Traffic volume is | February | 31.5 | 42,000
2,500 trucks per month. ODOT uses 13.5 inch dual | march 38.7 | 29,700
tire spacing, 4,500 Ib yvheel Ioad,_ and 100 psi contact April 450 | 1.800

pressure to characterize the design truck wheel load.

The design section is full-depth asphalt, with a 2 inch May 524 | 3,200
thick wearing course and a 4 inch thick base layer | 94ne 59.5 | 4,600
over soil subgrade. Anticipated HMA mix properties | July 66.1 | 7,500
for the wearing course are V, = 4.0%, Vp, = 11.0%, | August 65.9 | 7,560

P2 = 5.0%, Freq = 10 Hz., VIS(140F) = 1,800 | September | 57.1 7,500
Poises, and VIS(275F) = 260 cSt. Anticipated mix | October 46.4 | 7,500
properties for the base layer are the same, except |[‘November | 34.6 | 7,500
that the air voids are expected to be higher, V, =

7.0%. HMA stiffness is to be estimated by SW-1 December | 26.3 | 14,500
using the HMA mix properties evaluated at the
following evaluation temperatures in degrees
Fahrenheit: 10, 20, 30, 35, 40, 45, 50, 55, 60, 65, 70,
80. Average monthly air temperatures and subgrade
resilient modulus values for the past 12 months and
are shown in Table 18. What is the anticipated life
expectancy of this design scenario? How does the
life expectancy change if the base layer is increased
to 5 inches thick?

Solution:

1. Click New and create a new [FEErEEEEETRET

Project Detinman | Camae | Trafhc | Lyees | Mesuns |

project record. Select a | "

Pavement Use of Highways, | = v o e e

Roadways, and Streets and e T —— - G

select Advanced DAMA Analysis e P Tve

as the Project Type. o S
2. Click Next. oo N, o

Pesbireg Luts, Deseirmays. s Serae Siabuns
ey Cqupment

Fron Facidios and Hamvy Wisst Load & Ao Siuctes Asalysis [AMA}

Applcatons
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On the Climate screen, enter the
mean monthly air temperature for
each month of the year from the
information provided in Table 18—
Temperature and Subgrade MrTable
18.

Click Next.

On the Traffic screen, enter the
data from the Example Problem
statement including the tire
pressure, wheel load geometry
and load repetitions.

Click Next.

On the Layer Definition screen,
place your cursor in the grid and
establish the layer structure for
this problem. Use the Add Layer
Above, Add Layer Below, and
Remove Layer buttons as
needed and ensure that the
appropriate Poisson’s Ratio and
Thickness is entered. Also,
select the appropriate modulus
calculation procedure is selected.
For this problem, select Mix
Properties as the calculation
method for the HMA layers. For
the Subgrade layer, select Direct
Entry as the calculation
methodology.

Note how the screen layout
changes as changes are made to
the calculation method. Enter the
appropriate data in the Layers
screen to complete the problem
set up.

8. Click Next.
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9. On the Results screen scroll up or
down to view the Design
Summary. Select Detail to view
the detailed version of the report
including stress/strain conditions
at the calculation points. Use the
Print option to view a preview of
the complete report.

By scrolling down to the bottom of
the report, view the last section of
the report printout, the Design
Life Summary. For the first
design section of 2 inches
wearing course over a 4 inch
base course, note that the
design life is estimated to be
245 years, based on fatigue
failure in Layer 2.

10. Click Finish to reveal the screen
tabs. Now, select the Layers tab
and change the base layer
thickness to 5 inches.

Return to the Results tab and
scroll to the bottom of the report.
For this second analysis, note
that the estimated life is more
than doubled to 50.7 years,
based on fatigue failure in
Layer 2.
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Glossary

absolute viscosity a measure of the viscosity of asphalt with respect to time,
measured in poises, conducted at 60°C (140°F). The test method utilizes a partial
vacuum to induce flow in the viscometer.

aggregate a hard inert mineral material, such as gravel, crushed rock, slag,
or crushed stone, used in pavement applications either by itself or for mixing with
asphalt.

air carrier an aircraft that is used in scheduled and nonscheduled

commercial passenger and air cargo service.

air voids internal spaces in a compacted mix surrounded by asphalt-coated
particles, expressed as a percentage by volume of the total compacted mix.

aircraft movement one passage of a single aircraft at the critical design
location.
aircraft operation an aircraft arrival at or departure from an airport.

analysis period the period of time used in making economic comparisons between
alternative designs, including initial construction and future overlays. Analysis
period should not be confused with design period.

asphalt binder asphalt cement that is classified according to the Standard
Specification for Performance Graded Asphalt Binder, AASHTO Designation MP
320. It can be either unmodified or modified asphalt cement, as long as it complies
with the specifications.

asphalt a dark brown to black cementitious material in which the predominating
constituents is bitumen, which occurs in nature or are obtained in petroleum
processing. Asphalt is a constituent in varying proportions of most crude petroleum
and used for paving, roofing, industrial and other special purposes.

backcalculation an analytical technique used to determine the equivalent
elastic moduli of pavement layers corresponding to the measured load and
deflections. In the iterative method, layer moduli are selected and adjusted until the
difference between the calculated and measured deflections are within selected
tolerances, or the maximum number of iterations has been reached.

base course the layer in the pavement system immediately below the binder
and surface courses. It usually consists of crushed stone, although it may consist of
crushed slag or other stabilized or unstabilized material.

benkelman beam the Benkelman Beam measures deflection under a static
load such as a truck or aircraft. The truck weight is normally 18 kips (80 kN) on a
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single axle with dual tires. The tip of the beam is placed between the dual tires and
as the vehicle moves away, a measurement of the rebound deflection is made.

california bearing ratio (CBR) a test used for evaluating bases, subbases, and
subgrade soils for pavement thickness design. It is a relative measure of the shear
resistance of a soil (see Soils Manual, MS-10).

critical aircraft in the SW-1 method for design of asphalt pavements for general
aviation aircraft, the critical aircraft is the aircraft in the traffic mix with the highest
gross take-off weight.

critical design location the location where the most damage to the pavement is
anticipated in airport pavement thickness design.

DAMA  the computer program DAMA was developed at the University of
Maryland to provide the computational basis for developing the structural design
curves used in the Asphalt Institute design manuals. DAMA is an elastic-layered
pavement analysis program used to ascertain the repetitions to failure in the
deformation and fatigue cracking distress modes of a given pavement structure in a
given environment, subjected to any given design load configuration.

data file in SW-1, data files are created using the File>New commands and are
opened using the File>Open from the main menu. SW-1 creates a Microsoft
Access file with a .MDB extension. This file may contain numerous project records.

deflection basin the idealized shape of the deformed pavement surface as
a result of a cyclic or impact load as depicted from the peak measurements of five or
more deflection sensors.

deflection sensor the term that shall be used to refer to the electronic
device(s) capable of measuring the vertical movement of the pavement; and,
mounted in such a manner as to minimize angular rotation with respect to its
measuring plane at the expected movement. Sensor types include seismometers,
velocity transducers, and accelerometers.

deflection a load-induced, downward movement of a pavement section.

design ESAL  the total number of equivalent 18 kip (80 kN) single-axle load
applications (ESAL) expected throughout the design period.

design lane the lane on which the greatest number of equivalent 18 kip (80
kN) single axle loads (ESAL) is expected. This will normally be either lane of a two-
lane roadway or the outside lane of a multi-lane highway.

design period the number of years from the initial application of traffic until the
first planned major resurfacing or overlay. This term should not be confused with
pavement life or analysis period. Adding HMA overlays as required will extend
pavement life indefinitely or until geometric considerations (or other factors) make
the pavement obsolete.




design subgrade resilient modulus the value of the subgrade resilient modulus
(Mg) used for designing the pavement structure. It is a percentile value of the
subgrade resilient modulus test data distribution that varies with design ESAL. The
term design subgrade value is sometimes used.

design thickness the total thickness of the asphalt mixtures and untreated
aggregate layers determined as adequate for a given design situation.

dynaflect the Dynaflect is an electromechanical device for measuring
dynamic deflection. It is mounted on a two-wheel trailer and is stationary when the
measurements are taken. A 1,000 Ib (455 kg) peak-to-peak sinusoidal load is
applied through two eccentric masses that counter-rotate at a fixed frequency of 8
Hz. The load is applied through two rubber coated steel wheels. The counter-
rotating masses produce a sinusoidal pavement deflection which is recorded by
velocity transducers.

effective thickness the ratio of the thickness of an existing pavement material
compared to the equivalent thickness of a new HMA layer.

ESAL (equivalent single axle loads) the effect on pavement performance of any
combination of axle loads of varying magnitude equated to the number of 18 kip (80
kN) single-axle loads that are required to produce an equivalent effect.

falling weight deflectometer A falling weight deflectometer (FWD) is an impulse
loading device that measures pavement response due to the impulse load from a
free-falling mass falling onto a rubber buffer that is in contact with the pavement
surface. Pavement deflections and a deflection basin are measured using a series
of accelerometers.

fatigue resistance the ability of an HMA pavement to resist crack initiation
caused by repeated flexing.

full-depth asphalt pavement the term FULL-DEPTH (registered by the
Asphalt Institute with the U.S. Patent Office) certifies that the pavement is one in
which asphalt mixtures are employed for all courses above the subgrade or
improved subgrade. A Full-Depth asphalt pavement is placed directly on the

prepared subgrade.

functional overlay the primary purpose of a functional overlay is to restore
ride quality, improve surface texture, reduce pavement noise, or act as a
maintenance application. The structural benefits of a functional overlay are
considered secondary to the primary functional purpose of the treatment. A
functional overlay is normally a dense-graded HMA mixture in the range of 2 to 4 in.
(5 to 10 cm) thick.

general aviation all types of civil aircraft use other than commercial air_carriers.
This category covers a wide variety of activity including business, commercial, air
taxi, agricultural, aerial photography, pipeline patrol, student instruction, and
pleasure flying.
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heavy structural overlay heavy structural overlays range in thickness from 5
to 16 in. (15 to 40 cm). They have long expected life; however, their longevity relies
on proper pavement preparation and quality of construction.

heavy trucks  two-axle, six-tire trucks or larger. Pickup, panel and light four-tire
trucks are not included. Trucks with heavy-duty, wide-base tires are included.

highway capacity the practical capacity of a street or highway in terms of the
maximum number of vehicles of all types for which the highway should be
geometrically designed.

hot mix asphalt (HMA) overlay one or more courses of HMA over an
existing pavement.

hot mix asphalt (HMA) high quality, thoroughly controlled hot mixture of
asphalt binder (cement) and well-graded, high quality aggregate, which can be
compacted into a uniform dense mass.

improved subgrade subgrade that has been improved as a working platform
by: 1) the incorporation of granular materials or stabilizers such as asphalt, lime, or
portland cement into the subgrade soil; 2) any course or courses of select or
improved material placed on the subgrade soil below the pavement structure.

kinematic viscosity a measure of the viscosity of asphalt, measured in
centistokes, conducted at a temperature of 135°C (275°F).

MAAT  mean annual air temperature.

nondestructive testing (NDT) in the context of pavement evaluation, NDT is
deflection testing, without destruction to the pavement, to determine a pavement's
response to pavement loading.

pascal-seconds the Sl unit for viscosity. 1 Pascal-second equals 10 poises.

pass see aircraft movement

pavement structure  the entire pavement system of selected materials from
subgrade to the surface.

performance grade (PG) asphalt binder grade designation used in
Superpave. It is based on the binder's mechanical performance at critical
temperatures and aging conditions.

planned stage construction a construction process where stages of the project
are performed sequentially according to design and a predetermined time schedule.

poise a centimeter-gram-second unit of absolute viscosity equal to the viscosity
of a fluid in which a value of stress one dyne per square centimeter is required to
maintain a difference of velocity of one centimeter per second between two parallel
planes in the fluid that lie in the direction of flow and are separated by a distance of
one centimeter.




project record in SW-1 a project record is the record of an individual project or
problem that is stored within a SW-1. Many project records can be stored in a
single data file. Sample project records come with the SW-1 program and are
installed when SW-1 is installed on your computer.

rebound deflection the amount of surface rebound when a load is removed.
representative rebound deflection the mean value of measured rebound

deflections in a test section, plus two standard deviations, adjusted for temperature
and most critical period of the year for pavement performance.

residual deflection the difference between original and final elevations of the
pavement surface resulting from the application to, and removal of, one or more
loads from the surface.

resilient modulus of elasticity (Mz) a laboratory measurement of the behavior
of pavement materials to characterize their stiffness and resiliency (see Soils
Manual, MS-10). A confined or unconfined test specimen (core or re-compacted) is
repeatedly loaded and unloaded at a prescribed rate. The resilient modulus is a
function of load duration, load frequency, and number of loading cycles.

resistance value (R-value) a test for evaluating bases, subbases, and
subgrade for pavement thickness design.

road rater the Road Rater measures dynamic deflection using a sinusoidal
force generated by a hydraulic acceleration of a steel mass. Models are available
with peak-to-peak loading of 1,000 to 8,000 Ib. (455 to 3,630 kg). Pavement
response is measured at the center of the loading plate and at radial offset
distances using up to 7 velocity transducers.

standard aircraft the aircraft used to determine the traffic factor for design
purposes in the Asphalt Institute design procedure for air _carrier airports. Load
repetitions for the mix of aircraft traffic expected at the facility are converted to
equivalent strain repetitions of a “standard aircraft” at maximum gross weight of
358,000 Ib (1590 kN).

standard deviation the root-mean-square of the deviations about the
arithmetic mean of a set of values.

stoke a unit of kinematic viscosity equal to the viscosity of a fluid in poises
divided by the density of the fluid in grams per cubic centimeter.

structural overlay structural overlays add strength to the existing pavement
and typically ranges in thickness from 4 to 6 in. (10 to 15 cm).

subgrade resilient modulus the modulus of the subgrade determined by
repeated load, triaxial compression tests on soil samples. It is the ratio of the
amplitude of the accepted axial stress to the amplitude of the resultant recoverable
axial strain, generally designated by the symbol Mr.
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subgrade the soil prepared to support a pavement structure or a pavement
system. It is the foundation of the pavement structure.

truck factor the number of ESALs contributed by one passage of a vehicle.
Truck factors can apply to vehicles of a single type or class or to a group of vehicles
of different types.

viscosity a measure of a liquid's resistance to flow with respect to time.
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